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Discover and Auto Configure

IMPORTANT:   Discover and Auto Configure does not support long tags names or OPC UA.

The Discover and Auto Configure is a tool that you use to extract tag   information from PLC programming 
software files or OPC servers and then   add the tags to your target application's database. Using this tool 
saves   you valuable time and effort when creating tags for your driver(s) and   application database 
because you no longer need to manually create the   individual tags.

The Discover and Auto Configure uses wizards to make it easy for you   to extract tag information from a 
source file or OPC server and then add   that tag information to your target application database. The 
Select a   Discovery Agent wizard takes you through the necessary steps to:

 l Choose   a Discovery Agent.

 l Choose the specific   source   file or OPC   server you want to extract the tag information from. 

The Discovery Agent is specific to the programming software you are   extracting information from. For 
example, the Siemens S7 Discovery Agent   can be used only with Siemens .s7p project files and the 
OPC Discovery   Agent can be used only with OPC servers. The extracted tag information   is used to cre-
ate new tags in your database and assist in configuring   drivers.

After the tag information is extracted, it is displayed in a spreadsheet.   From this spreadsheet you 
choose   the tags you want to add to the target database. The toolbar provides   access to another set of 
wizards that you can run individually or as a   single wizard. These wizards allow you to:

 l Create   tag names.

 l Configure   tag information to display in the spreadsheet.

 l Choose   the driver the tags will be added to. 

 l Add   the tags to iFIX.

IMPORTANT:   The Discover and Auto Configure supports datablock numbers up to 65535.   However, the indi-
vidual drivers do not necessarily support the same number   of datablocks. You can create up to 65535 tags to 
add to the target database,   but if the selected driver supports fewer datablocks, the database fails   the I/O 
addresses that exceed the driver's maximum datablocks. For information   about the maximum number of 
driver datablocks, refer to the specific driver   topics.

Assumptions and Preconditions for Using the   Discover and Auto Configure

The following conditions must be met before you can use the Discover   and Auto Configure.

Siemens®   S7™   Discovery Agent

This information is specific to the Siemens S7 Discovery Agent and iFIX®.

Drivers:

 l The GE    SI7 version 7.2x or the Industrial Communications Solution (InCoSol)    S7A version 7.2x 
driver is installed on the same machine as the Discover   and Auto Configure. 
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 l The channel and device    information for the selected driver are configured. If the channel and/or   
device you want is not available, you can launch the driver configuration   tool and add the required 
information.

 l The driver you are   using must be running so that it can be configured if necessary, but does   not 
have to be communicating with the PLC hardware.

Siemens Software and Hardware

 l The PLC is configured   using the appropriate programming software and the project files asso-
ciated   with the project are accessible to the Discover and Auto Configure. This   includes all the 
other files in the sub-directories within the project   directory.

NOTE:   If the project files are located on a shared (mapped) drive on a remote   machine, that shared 
drive must have the allow Read/Write/Modify/Full   Control option enabled; otherwise, the project can-
not be opened.

 l The computer that   the Discover and Auto Configure is installed on does not have to be connected   
to the PLC hardware. This tool is independent of the actual PLC communications.   The driver 
handles all communications with the PLC hardware.

OPC Discovery Agent

This information is specific to the OPC Discovery Agent and iFIX.

Drivers

 l The iFIX OPC Client   Driver version 7.3x driver is installed on the same machine as the Discover   
and Auto Configure. This driver is automatically installed with iFIX 4.0    or greater.

 l The iFIX OPC Client   Driver must be running so that it can be configured if necessary, but   does 
not have to be communicating with the OPC Servers.

OPC Servers

 l OPC servers support   OPC Data Access specification v1.0a and v2.05 on both the local and 
remote   machine.

 l OPC servers support   browsing of OPC tags.

 l OPC server software   is installed on the local or remote computer.

 l OPC servers on a   remote computer must be accessible through the local area network.

 l OPC servers on both   the local and remote computer(s) must be correctly set up for DCOM com-
munications,   including any Windows Firewall settings, DCOM settings, OPC Server / OPC   Cli-
ent settings, and any other network settings.

 l Connection to the   data source (that is, a PLC or some other data source) may be required   in order 
to browse the tags in the selected OPC server.

 l If you are browsing   OPC servers on a remote machine, then OPCENUM must reside and be 
registered   on that remote machine for the browse to work correctly. While most OPC   server 
applications install and register this file, some may not. You   can download this file from www.op-
cfoundation.org.   Currently, it is contained within the OPC Core Components 2.00 Redistributable   
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2.30.msi file. After you download the file, run the .msi program and follow   the instructions on 
screen to install it. You must do this on each of   the remote machines you intend to browse. For 
more detailed information,   refer to Setting   Up DCOM for Discovery of Remote OPC Servers.

Allen-Bradley PLC-5®   / SLC 500™   / MicroLogix™   Discovery Agent

This information is specific to the Allen-Bradley PLC-5 / SLC 500 /   MicroLogix Discovery Agent and 
iFIX.

Drivers:

 l The GE   ABR version 7.2x driver is installed on the same machine as    the Discover and Auto Con-
figure. 

 l The channel and device    information for the selected driver are configured. If the channel and/or   
device you want is not available, you can launch the driver configuration   tool and add the required 
information.

 l The driver you are   using must be running so that it can be configured if necessary, but does   not 
have to be communicating with the PLC hardware.

Allen-Bradley®   / Rockwell®   Software and Hardware

 l The PLC is configured   using the appropriate programming software (RSLogix™ 5   or RSLogix™   
500) and the project export files (with the .EAS extension) associated   with the project are access-
ible to the Discover and Auto Configure. 

NOTE:   If the project files are located on a shared (mapped) drive on a remote   machine, that shared 
drive must have the allow Read/Write/Modify/Full   Control option enabled; otherwise, the project can-
not be opened.

 l The computer that   the Discover and Auto Configure is installed on does not have to be connected   
to the PLC hardware. This tool is independent of the actual PLC communications.   The driver 
handles all communications with the PLC hardware.

 l For the ABR driver   to run, you need the appropriate RSLinx®   software installed and configured. 
Please refer to the ABR Driver Documentation   for a complete list of ABR Driver requirements.

IGS - Industrial Gateway Server Discovery Agent

This information is specific to the IGS - Industrial Gateway Server   Discovery Agent and iFIX.

Drivers:

 l The GE    IGS version 7.41 and 7.51 or greater driver is installed on   the same machine as the Dis-
cover and Auto Configure. 

 l The channel and device   information for the selected driver are configured. If the channel and/or   
device you want is not available, you can launch the driver configuration   tool and add the required 
information.

 l The driver you are   using must be running so that it can be configured if necessary, but does   not 
have to be communicating with the PLC hardware.
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Allen-Bradley®   / Rockwell®   Software and Hardware

 l The PLC is configured   using the appropriate programming software (RSLogix™ 5000)   and the pro-
ject export files (with the .L5K extension) associated with   the project are accessible to the Dis-
cover and Auto Configure. 

NOTE:   If the project files are located on a shared (mapped) drive on a remote   machine, that shared 
drive must have the allow Read/Write/Modify/Full   Control option enabled; otherwise, the project can-
not be opened.

 l The computer that   the Discover and Auto Configure is installed on does not have to be connected   
to the PLC hardware. This tool is independent of the actual PLC communications.   The driver 
handles all communications with the PLC hardware.

All Discovery Agents

Drivers Used with iFIX

 l The driver must be added to the iFIX SCU (System    Configuration Utility), in the Configured I/O 
Drivers list before it can   be configured to run in iFIX and be used with the Discover and Auto Con-
figure.

NOTE:   If iFIX is running, you must shut down and restart iFIX for your changes   to take effect.

 l The driver you use   must be running so that it can be configured if necessary, but does not   have to 
be communicating with the PLC hardware.

 l The necessary driver   configuration file is set as the default to load on driver startup.

 l The default configuration   file is open.

 l The default configuration   file for the locally installed driver is used by the Discover and Auto   Con-
figure when you are working with the Device (or Group) Selection page   of the Driver Wizard. If 
you connect to a remote driver's Power Tool,   its configuration file is not displayed in the Device 
(or Group) Selection   page of the Driver Wizard.

 l The driver's Auto   Create option is enabled. This allows the database to automatically add   I/O 
addresses to the driver configuration. For more information, refer   to the online help for the selec-
ted driver.

Discover and Auto Configure

 l Only one Discovery   Agent can run at any given time.

Target Applications

 l iFIX 4.0 or greater   is installed and running.

 l The iFIX node you   are running must be a SCADA node.

 l The target database   is loaded in order to add tags to the database. You can create a new data-
base   or load an existing one; however, the database must be the local database.   You cannot add 
or modify tags in a database located on a remote SCADA   node.

IMPORTANT:
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 l The Discover   and Auto Configure, the Discovery Agent, the target application, and the   target driver 
must all be installed and running on the same machine. 

 l The Discover   and Auto Configure does not support remote configurations; however, the   OPC Dis-
covery Agent supports connections to remote OPC servers, as described   above.
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Discover and Auto Configure Important Product   Information

System Requirements
IMPORTANT:   You must have Administrative rights to install and run the Discover and   Auto Configure tool. All 
users needing access to the Discover and Auto   Configure tool must have Full Control to the folder where the 
Discover   and Auto Configure tool is installed. 

Be aware that before you make any security   changes you should consult with your IT department concerning 
your local   security policies. Any inadvertent changes   may affect the entire system and may cause some or all 
programs to stop   working.

To check your security settings, in Windows   Explorer, right-click the folder where you installed the Discover 
and   Auto Configure tool, and select Properties. Click the Security tab. In   the Group or User Names area, 
select the Users group (which contains your   user account). In the Permissions area, select the Full Control 
check   box, and click Apply. Additionally on this same dialog box, you should   check the permissions on child 
objects in the Advanced settings. To do   this, on the Security tab, click the Advanced button and confirm that   
the "Replace permission entries on all child objects with entries   shown here apply to child objects" check box 
is selected. If it is   not, select the check box and click Apply. 

Important Information about Windows Firewall Security

The following software is required to run the Discover and Auto Configure:

Operating Systems

 l Microsoft® Windows®   XP Professional, with Service Pack 3 or greater.

 l Microsoft® Windows®   Server 2003, Service Pack 2, Standard or Enterprise Edition. 

 l Microsoft® Windows®   Server 2008 (32-bit), Service Pack 2, Standard or Enterprise Edition.   

 l Microsoft® Windows®    Server 2008 R2 (64-bit), Standard or Enterprise Edition. 

 l Microsoft® Windows®   7 (32-bit or 64-bit), Professional, Enterprise, or Ultimate Edition. 

IMPORTANT:   If you want to run Discover and Auto Configure on any of these supported   operating systems, 
make sure that your version of iFIX supports that operating   system. Similarly, the driver which you plan to use 
with Discover and   Auto Configure must also support that operating system. For example, if   the driver is not 
supported on a 64-bit system, then you cannot use Discover   and Auto Configure on that system.

GE Software

 l iFIX 4.0 or greater

Additional Software

 l Internet Explorer   5.01 or greater (required for .NET Framework)

Important Information about Windows Firewall Security

If Firewall security is enabled, you may need to modify or add items to the Exceptions   list. For more 
information, refer to the Windows Server 2008 Firewall for Discovery   of Remote OPC Servers topic.

© 2020 General Electric Company. All rights reserved. 7



Supported Drivers

When using the OPC Discovery Agent:

 l GE   OPC Client version 7.4x

When using the IGS - Industrial Gateway Server Discovery Agent:

 l GE   IGS version 7.41 and 7.51 or greater, I/O driver

NOTE:   The GE IGS driver version 7.50 is not supported.

IMPORTANT:   If you are running IGS version 7.53a or later, be aware that only one   configuration tool 
can be connected and running at any given time.  If   the IGS Configuration tool is open and you attempt 
to run the IGS - Industrial   Gateway Server Discovery Agent, a message will be posted in the server   log 
window stating that more than one connection cannot be made. The solution   is to shutdown both 
applications, and then restart the IGS - Industrial   Gateway Server Discovery Agent.

When using the Siemens S7 Discovery Agent:

 l Industrial Communications   Solution (InCoSol) S7a version 7.2x driver.

 l GE   SI7 version 7.2x.

When using the Allen-Bradley Bradley PLC-5 / SLC 500 / MicroLogix  Discovery   Agent:

 l GE   ABR version 7.2x.

GE recommends obtaining and installing the latest   drivers. Driver updates can be obtained from the 
GlobalCare Support   web site: https://digitalsupport.ge.com   and click I/O Drivers in the Downloads area.

Supported Hardware

The following hardware applies when using the Allen-Bradley Bradley   PLC-5 / SLC 500 / MicroLogix Dis-
covery Agent:

 l Allen-Bradley PLC-5

 l SLC 500

 l MicroLogix 

The following hardware applies when using the IGS - Industrial Gateway   Server Discovery Agent:

 l Allen-Bradley ControlLogix   Family of PLCs.

 l Any hardware models   supported by the various IGS protocol drivers as configured in the IGS   
driver configuration.  The   option to “Browse current IGS Driver Configuration” is available in the   
Discovery Agent Selection Wizard after choosing the IGS as your Discovery   Agent.

The following hardware applies when using the Siemens S7 Discovery Agent:

 l Siemens S7-300

 l Siemens S7-400

The supported SIMATIC 300 CPUs include:
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 l Baugruppe MLFB Firmware

 l CPU 312 6ES7 312-1AD10-0AB0   V2.0

 l CPU 312 6ES7 312-1AE13-0AB0   V2.0

 l CPU 312IFM 6ES7 312-5AC00-0AB0   -

 l CPU 312IFM 6ES7 312-5AC01-0AB0   -

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.0

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.1

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.2

 l CPU 312IFM 6ES7 312-5AC81-0AB0   -

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.0

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.1

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.2

 l CPU 312C 6ES7 312-5BD00-0AB0   V1.0

 l CPU 312C 6ES7 312-5BD01-0AB0   V2.0

 l CPU 312C 6ES7 312-5BE03-0AB0   V2.0

 l CPU 313 6ES7 313-1AD00-0AB0   -

 l CPU 313 6ES7 313-1AD01-0AB0   -

 l CPU 313 6ES7 313-1AD02-0AB0   -

 l CPU 313 6ES7 313-1AD03-0AB0   V1.0

 l CPU 313 6ES7 313-1AD03-0AB0   V1.1

 l CPU 313 6ES7 313-1AD03-0AB0   V1.2

 l CPU 313C 6ES7 313-5BE00-0AB0   V1.0

 l CPU 313C 6ES7 313-5BE01-0AB0   V2.0

 l CPU 313C 6ES7 313-5BF03-0AB0   V2.0

 l CPU 313C-2 DP 6ES7   313-6CE00-0AB0 V1.0

 l CPU 313C-2 DP 6ES7   313-6CE01-0AB0 V2.0

 l CPU 313C-2 DP 6ES7   313-6CF03-0AB0 V2.0

 l CPU 313C-2 PtP 6ES7   313-6BE00-0AB0 V1.0

 l CPU 313C-2 PtP 6ES7   313-6BE01-0AB0 V2.0

 l CPU 313C-2 PtP 6ES7   313-6BF03-0AB0 V2.0

 l CPU 314 6ES7 314-1AE01-0AB0   -

 l CPU 314 6ES7 314-1AE02-0AB0   -

 l CPU 314 6ES7 314-1AE03-0AB0   -

 l CPU 314 6ES7 314-1AE04-0AB0   V1.0

 l CPU 314 6ES7 314-1AE04-0AB0   V1.1

 l CPU 314 6ES7 314-1AE04-0AB0   V1.2
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 l CPU 314 6ES7 314-1AE83-0AB0   -

 l CPU 314 6ES7 314-1AE84-0AB0   V1.0

 l CPU 314 6ES7 314-1AE84-0AB0   V1.1

 l CPU 314 6ES7 314-1AE84-0AB0   V1.2

 l CPU 314 6ES7 314-1AF10-0AB0   V2.0

 l CPU 314 6ES7 314-1AF11-0AB0   V2.0

 l CPU 314 6ES7 314-1AG13-0AB0   V2.0

 l CPU 314 IFM 6ES7   314-5AE00-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE01-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE02-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.0

 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.1

 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.2

 l CPU 314 IFM 6ES7   314-5AE10-0AB0 V1.1

 l CPU 314 IFM-MC 6ES7   314-5AE10-0AB0 V1.2

 l CPU 314 IFM 6ES7   314-5AE82-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.0

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.1

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.2

 l CPU 314C-2 DP 6ES7   314-6CF00-0AB0 V1.0

 l CPU 314C-2 DP 6ES7   314-6CF01-0AB0 V2.0

 l CPU 314C-2 DP 6ES7   314-6CF02-0AB0 V2.0

 l CPU 314C-2 DP 6ES7   314-6CG03-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BF00-0AB0 V1.0

 l CPU 314C-2 PtP 6ES7   314-6BF01-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BF02-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BG03-0AB0 V2.0

 l CPU 315 6ES7 315-1AF00-0AB0   -

 l CPU 315 6ES7 315-1AF01-0AB0   -

 l CPU 315 6ES7 315-1AF02-0AB0   -

 l CPU 315 6ES7 315-1AF03-0AB0   V1.0

 l CPU 315 6ES7 315-1AF03-0AB0   V1.1

 l CPU 315 6ES7 315-1AF03-0AB0   V1.2

 l CPU 315-2 DP 6ES7   315-2AF00-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF01-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF02-0AB0 -
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 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.0

 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.1

 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.2

 l CPU 315-2 DP 6ES7   315-2AF82-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.0

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.1

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.2

 l CPU 315-2 DP 6ES7   315-2AG10-0AB0 V2.0

 l CPU 315-2 PN/DP 6ES7   315-2EG10-0AB0 V2.3

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.3

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.5

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.6

 l CPU 315F-2 DP 6ES7   315-6FF00-0AB0 V1.0

 l CPU 315F-2 DP 6ES7   315-6FF01-0AB0 V1.0

 l CPU 315F-2 DP 6ES7   315-6FF01-0AB0 V2.0

 l CPU 315F-2 PN/DP   6ES7 315-2FH10-0AB0 V2.3

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.3

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.5

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.6

 l CPU 316 6ES7 316-1AG00-0AB0   -

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.0

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.1

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.2

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.1

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.5

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.6

 l CPU 317-2 PN/DP 6ES7   317-2EJ10-0AB0 V2.2

 l CPU 317-2 PN/DP 6ES7   317-2EJ10-0AB0 V2.3

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.3

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.5

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.6

 l CPU 317F-2 6ES7 317-6FF00-0AB0   V2.1

 l CPU 317F-2 6ES7 317-6FF03-0AB0   V2.1

 l CPU 317F-2 6ES7 317-6FF03-0AB0   V2.5

 l CPU 317F-2 DP 6ES7   317-6FF03-0AB0 V2.6

 l CPU 317F-2 PN/DP   6ES7 317-2FJ10-0AB0 V2.3
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 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.3

 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.5

 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.6

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.0

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.1

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.2

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V3.0

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.4

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.5

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.6

 l CPU 319F-3 PN/DP   6ES7 318-3FL00-0AB0 V2.5

 l CPU 614 6ES7 614-1AH00-0AB3   -

 l CPU 614 6ES7 614-1AH01-0AB3   -

 l CPU 614 6ES7 614-1AH02-0AB3   -

 l CPU 614 6ES7 614-1AH03-0AB3   V1.0

 l CPU 614 6ES7 614-1AH03-0AB3   V1.1

 l CPU 614 6ES7 614-1AH03-0AB3   V1.2

The supported SIMATIC 400 CPUs include:

 l Baugruppe MLFB Firmware

 l CPU 412-1 6ES7 412-1XF00-0AB0   -

 l CPU 412-1 6ES7 412-1XF01-0AB0   -

 l CPU 412-1 6ES7 412-1XF02-0AB0   -

 l CPU 412-1 6ES7 412-1XF03-0AB0   V1.1

 l CPU 412-1 6ES7 412-1XF03-0AB0   V1.2

 l CPU 412-1 6ES7 412-1XF03-0AB0   V3.0

 l CPU 412-1 6ES7 412-1XF03-0AB0   V3.1

 l CPU 412-1 6ES7 412-1XF04-0AB0   V4.0

 l CPU 412-1 6ES7 412-1XF04-0AB0   V4.1

 l CPU 412-1 6ES7 412-1XJ05-0AB0   V5.0

 l CPU 412-1 6ES7 412-1XJ05-0AB0   V5.1

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V1.1

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V1.2

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V3.0

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V3.1

 l CPU 412-2 DP 6ES7   412-2XG04-0AB0 V4.0
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 l CPU 412-2 DP 6ES7   412-2XG04-0AB0 V4.1

 l CPU 412-2 DP 6ES7   412-2XJ05-0AB0 V5.0

 l CPU 412-2 DP 6ES7   412-2XJ05-0AB0 V5.1

 l CPU 413-1 6ES7 413-1XG00-0AB0   -

 l CPU 413-1 6ES7 413-1XG01-0AB0   -

 l CPU 413-1 6ES7 413-1XG02-0AB0   -

 l CPU 413-2 DP 6ES7   413-2XG00-0AB0 -

 l CPU 413-2 DP 6ES7   413-2XG01-0AB0 -

 l CPU 413-2 DP 6ES7   413-2XG02-0AB0 -

 l CPU 414-1 6ES7 414-1XG00-0AB0   -

 l CPU 414-1 6ES7 414-1XG01-0AB0   -

 l CPU 414-1 6ES7 414-1XG02-0AB0   -

 l CPU 414-2 DP 6ES7   414-2XG00-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG01-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG02-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V1.1

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V1.2

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V3.0

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V3.1

 l CPU 414-2 DP 6ES7   414-2XG04-0AB0 V4.0

 l CPU 414-2 DP 6ES7   414-2XG04-0AB0 V4.1

 l CPU 414-2 DP 6ES7   414-2XJ00-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XJ01-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XK05-0AB0 V5.0

 l CPU 414-2 DP 6ES7   414-2XK05-0AB0 V5.1

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V1.1

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V1.2

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V3.0

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V3.1

 l CPU 414-3 DP 6ES7   414-3XJ04-0AB0 V4.0

 l CPU 414-3 DP 6ES7   414-3XJ04-0AB0 V4.1

 l CPU 414-3 DP 6ES7   414-3XM05-0AB0 V5.0

 l CPU 414-3 DP 6ES7   414-3XM05-0AB0 V5.1

 l CPU 414-3 PN/DP 6ES7   414-3EM05-0AB0 V5.0

 l CPU 414-3 PN/DP 6ES7   414-3EM05-0AB0 V5.1

 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V2.1
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 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V3.0

 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V3.1

 l CPU 414-4 H 6ES7   414-4HJ04-0AB0 V4.0

 l CPU 416-1 6ES7 416-1XJ00-0AB0   -

 l CPU 416-1 6ES7 416-1XJ01-0AB0   -

 l CPU 416-1 6ES7 416-1XJ02-0AB0   -

 l CPU 416-2 DP 6ES7   416-2XK00-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XK01-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V1.1

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V1.2

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V3.0

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V3.1

 l CPU 416-2 DP 6ES7   416-2XK04-0AB0 V4.0

 l CPU 416-2 DP 6ES7   416-2XK04-0AB0 V4.1

 l CPU 416-2 DP 6ES7   416-2XL00-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XL01-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XN05-0AB0 V5.0

 l CPU 416-2 DP 6ES7   416-2XN05-0AB0 V5.1

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V1.1

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V1.2

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V3.0

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V3.1

 l CPU 416-3 DP 6ES7   416-3XL04-0AB0 V4.0

 l CPU 416-3 DP 6ES7   416-3XL04-0AB0 V4.1

 l CPU 416-3 DP 6ES7   416-3XR05-0AB0 V5.0

 l CPU 416-3 DP 6ES7   416-3XR05-0AB0 V5.1

 l CPU 416-3 PN/DP 6ES7   416-3ER05-0AB0 V5.0

 l CPU 416-3 PN/DP 6ES7   416-3ER05-0AB0 V5.1

 l CPU 416F-2 6ES7 416-2FK02-0AB0   V3.1

 l CPU 416F-2 6ES7 416-2FK04-0AB0   V4.0

 l CPU 416F-2 6ES7 416-2FK04-0AB0   V4.1

 l CPU 416F-2 6ES7 416-2FN05-0AB0   V5.0

 l CPU 416F-2 6ES7 416-2FN05-0AB0   V5.1

 l CPU 416F-3 PN/DP   6ES7 416-3FR05-0AB0 V5.0

 l CPU 416F-3 PN/DP   6ES7 416-3FR05-0AB0 V5.1

 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.0
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 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.1

 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.2

 l CPU 417-4 6ES7 417-4XL00-0AB0   V3.0

 l CPU 417-4 6ES7 417-4XL00-0AB0   V3.1

 l CPU 417-4 6ES7 417-4XL04-0AB0   V4.0

 l CPU 417-4 6ES7 417-4XL04-0AB0   V4.1

 l CPU 417-4 6ES7 417-4XT05-0AB0   V5.0

 l CPU 417-4 6ES7 417-4XT05-0AB0   V5.1

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V1.1

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V2.0

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V2.1

 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V2.1

 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V3.0

 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V3.1

 l CPU 417-4 H 6ES7   417-4HL04-0AB0 V4.0

Supported OPC Data Access Versions

The following applies when using the OPC Discovery Agent:

 l 1.0a

 l 2.0x

New Features

 l IGS - Industrial   Gateway Server Discovery Agent (added in Discover and Auto Configure 4.0   and 
greater)

 l Support for iFIX   5.5

 l Support for   Historian related fields in iFIX 5.0 and greater

General Information

 l iFIX 4.0   or greater must be installed and running on the same machine as the Discover    and Auto 
Configure.

 l The iFIX node you    are running must be a SCADA node.

 l The target database   must be loaded and must be the local database; you cannot add or modify   
tags in a database located on a remote SCADA node.

 l The driver you are   adding database tags to must be installed on the same machine as the Dis-
cover   and Auto Configure.
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 l The driver (ABR,   IGS, S7A, SI7, or OPC Client) must be added to the iFIX SCU's Configured   I/O 
Drivers list.

 l The necessary driver   configuration file is set as the default to load on driver startup, and   if the 
driver is already running, the default configuration file is open.

 l The driver should   have the Auto-Create option enabled.

NOTES:   

 l If   the driver Auto-Create flag is disabled, you may not be able to add the   configured tags to the 
driver configuration.

 l The   driver wizard may give you an option to set the Auto-Create flag to ON. This feature may 
not take   effect immediately. You may need to shut down and restart the driver (and   con-
sequently, iFIX and the Discovery Tool) for this to take effect.

Known Issues

Using the GE OPC Client driver v7.34 or earlier:

 l OPC servers installed   on remote machines must also be installed on the local machine in order   to 
access them.
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Supported Software

Operating System

 l Microsoft® Windows®   XP Professional, with Service Pack 3 or greater.

 l Microsoft® Windows®   Server 2003, Service Pack 2, Standard or Enterprise Edition. 

 l Microsoft® Windows®   Server 2008 (32-bit), Service Pack 2, Standard or Enterprise Edition.   

 l Microsoft® Windows®   Server 2008 R2 (64-bit), Standard or Enterprise Edition. 

 l Microsoft® Windows®   7 (32-bit or 64-bit), Professional, Enterprise, or Ultimate Edition. 

IMPORTANT:   If you want to run Discover and Auto Configure on any of these supported   operating systems, 
make sure that your version of iFIX supports that operating   system. Similarly, the driver which you plan to use 
with Discover and   Auto Configure must also support that operating system. For example, if   the driver is not 
supported on a 64-bit system, then you cannot use Discover   and Auto Configure on that system.

OPC Servers

Any OPC server that supports the OLE for Process Control specification   v1.0a or v2.05. 

NOTE:   Using a Human-Machine Interface (HMI) software package is not required   to use the OPC Client. 
However, if you choose to use an HMI software package,   select one of the following:

 l FIX for Windows NT version   6.15 or greater. Latched data support requires FIX 6.15 with a special   
SACDLL SIM. Contact Technical Support to obtain the SIM.

 l iFIX version 2.1 or greater.

 l A third-party HMI software   package.
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Supported Hardware

The following families of PLC's are supported by the Discover and Auto   Configure:

Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery   Agent

The Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery Agent   supports the following PLC 
families.

 l Allen-Bradley PLC-5

 l SLC 500

 l MicroLogix 

IGS - Industrial Gateway Server Discovery Agent

The IGS - Industrial Gateway Server Discovery Agent supports the following   hardware:

 l Allen-Bradley ControlLogix   Family of PLCs

 l Any hardware models   supported by the various IGS protocol drivers as configured in the IGS   
driver configuration.  The   option to “Browse current IGS Driver Configuration” is available in the   
Discovery Agent Selection Wizard after choosing the IGS as your Discovery   Agent.

Siemens S7 Discovery Agent

The Siemens S7 Discovery Agent supports the following PLC families.

 l S7-300

 l S7-400

The supported SIMATIC 300 CPUs include:

 l Baugruppe MLFB Firmware

 l CPU 312 6ES7 312-1AD10-0AB0   V2.0

 l CPU 312 6ES7 312-1AE13-0AB0   V2.0

 l CPU 312IFM 6ES7 312-5AC00-0AB0   -

 l CPU 312IFM 6ES7 312-5AC01-0AB0   -

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.0

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.1

 l CPU 312IFM 6ES7 312-5AC02-0AB0   V1.2

 l CPU 312IFM 6ES7 312-5AC81-0AB0   -

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.0

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.1

 l CPU 312IFM 6ES7 312-5AC82-0AB0   V1.2
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 l CPU 312C 6ES7 312-5BD00-0AB0   V1.0

 l CPU 312C 6ES7 312-5BD01-0AB0   V2.0

 l CPU 312C 6ES7 312-5BE03-0AB0   V2.0

 l CPU 313 6ES7 313-1AD00-0AB0   -

 l CPU 313 6ES7 313-1AD01-0AB0   -

 l CPU 313 6ES7 313-1AD02-0AB0   -

 l CPU 313 6ES7 313-1AD03-0AB0   V1.0

 l CPU 313 6ES7 313-1AD03-0AB0   V1.1

 l CPU 313 6ES7 313-1AD03-0AB0   V1.2

 l CPU 313C 6ES7 313-5BE00-0AB0   V1.0

 l CPU 313C 6ES7 313-5BE01-0AB0   V2.0

 l CPU 313C 6ES7 313-5BF03-0AB0   V2.0

 l CPU 313C-2 DP 6ES7   313-6CE00-0AB0 V1.0

 l CPU 313C-2 DP 6ES7   313-6CE01-0AB0 V2.0

 l CPU 313C-2 DP 6ES7   313-6CF03-0AB0 V2.0

 l CPU 313C-2 PtP 6ES7   313-6BE00-0AB0 V1.0

 l CPU 313C-2 PtP 6ES7   313-6BE01-0AB0 V2.0

 l CPU 313C-2 PtP 6ES7   313-6BF03-0AB0 V2.0

 l CPU 314 6ES7 314-1AE01-0AB0   -

 l CPU 314 6ES7 314-1AE02-0AB0   -

 l CPU 314 6ES7 314-1AE03-0AB0   -

 l CPU 314 6ES7 314-1AE04-0AB0   V1.0

 l CPU 314 6ES7 314-1AE04-0AB0   V1.1

 l CPU 314 6ES7 314-1AE04-0AB0   V1.2

 l CPU 314 6ES7 314-1AE83-0AB0   -

 l CPU 314 6ES7 314-1AE84-0AB0   V1.0

 l CPU 314 6ES7 314-1AE84-0AB0   V1.1

 l CPU 314 6ES7 314-1AE84-0AB0   V1.2

 l CPU 314 6ES7 314-1AF10-0AB0   V2.0

 l CPU 314 6ES7 314-1AF11-0AB0   V2.0

 l CPU 314 6ES7 314-1AG13-0AB0   V2.0

 l CPU 314 IFM 6ES7   314-5AE00-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE01-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE02-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.0

 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.1
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 l CPU 314 IFM 6ES7   314-5AE03-0AB0 V1.2

 l CPU 314 IFM 6ES7   314-5AE10-0AB0 V1.1

 l CPU 314 IFM-MC 6ES7   314-5AE10-0AB0 V1.2

 l CPU 314 IFM 6ES7   314-5AE82-0AB0 -

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.0

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.1

 l CPU 314 IFM 6ES7   314-5AE83-0AB0 V1.2

 l CPU 314C-2 DP 6ES7   314-6CF00-0AB0 V1.0

 l CPU 314C-2 DP 6ES7   314-6CF01-0AB0 V2.0

 l CPU 314C-2 DP 6ES7   314-6CF02-0AB0 V2.0

 l CPU 314C-2 DP 6ES7   314-6CG03-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BF00-0AB0 V1.0

 l CPU 314C-2 PtP 6ES7   314-6BF01-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BF02-0AB0 V2.0

 l CPU 314C-2 PtP 6ES7   314-6BG03-0AB0 V2.0

 l CPU 315 6ES7 315-1AF00-0AB0   -

 l CPU 315 6ES7 315-1AF01-0AB0   -

 l CPU 315 6ES7 315-1AF02-0AB0   -

 l CPU 315 6ES7 315-1AF03-0AB0   V1.0

 l CPU 315 6ES7 315-1AF03-0AB0   V1.1

 l CPU 315 6ES7 315-1AF03-0AB0   V1.2

 l CPU 315-2 DP 6ES7   315-2AF00-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF01-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF02-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.0

 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.1

 l CPU 315-2 DP 6ES7   315-2AF03-0AB0 V1.2

 l CPU 315-2 DP 6ES7   315-2AF82-0AB0 -

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.0

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.1

 l CPU 315-2 DP 6ES7   315-2AF83-0AB0 V1.2

 l CPU 315-2 DP 6ES7   315-2AG10-0AB0 V2.0

 l CPU 315-2 PN/DP 6ES7   315-2EG10-0AB0 V2.3

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.3

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.5

 l CPU 315-2 PN/DP 6ES7   315-2EH13-0AB0 V2.6
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 l CPU 315F-2 DP 6ES7   315-6FF00-0AB0 V1.0

 l CPU 315F-2 DP 6ES7   315-6FF01-0AB0 V1.0

 l CPU 315F-2 DP 6ES7   315-6FF01-0AB0 V2.0

 l CPU 315F-2 PN/DP   6ES7 315-2FH10-0AB0 V2.3

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.3

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.5

 l CPU 315F-2 PN/DP   6ES7 315-2FH13-0AB0 V2.6

 l CPU 316 6ES7 316-1AG00-0AB0   -

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.0

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.1

 l CPU 316-2 DP 6ES7   316-2AG00-0AB0 V1.2

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.1

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.5

 l CPU 317-2 6ES7 317-2AJ10-0AB0   V2.6

 l CPU 317-2 PN/DP 6ES7   317-2EJ10-0AB0 V2.2

 l CPU 317-2 PN/DP 6ES7   317-2EJ10-0AB0 V2.3

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.3

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.5

 l CPU 317-2 PN/DP 6ES7   317-2EK13-0AB0 V2.6

 l CPU 317F-2 6ES7 317-6FF00-0AB0   V2.1

 l CPU 317F-2 6ES7 317-6FF03-0AB0   V2.1

 l CPU 317F-2 6ES7 317-6FF03-0AB0   V2.5

 l CPU 317F-2 DP 6ES7   317-6FF03-0AB0 V2.6

 l CPU 317F-2 PN/DP   6ES7 317-2FJ10-0AB0 V2.3

 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.3

 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.5

 l CPU 317F-2 PN/DP   6ES7 317-2FK13-0AB0 V2.6

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.0

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.1

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V1.2

 l CPU 318-2 6ES7 318-2AJ00-0AB0   V3.0

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.4

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.5

 l CPU 319-3 PN/DP 6ES7   318-3EL00-0AB0 V2.6

 l CPU 319F-3 PN/DP   6ES7 318-3FL00-0AB0 V2.5

 l CPU 614 6ES7 614-1AH00-0AB3   -
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 l CPU 614 6ES7 614-1AH01-0AB3   -

 l CPU 614 6ES7 614-1AH02-0AB3   -

 l CPU 614 6ES7 614-1AH03-0AB3   V1.0

 l CPU 614 6ES7 614-1AH03-0AB3   V1.1

 l CPU 614 6ES7 614-1AH03-0AB3   V1.2

The supported SIMATIC 400 CPUs include:

 l Baugruppe MLFB Firmware

 l CPU 412-1 6ES7 412-1XF00-0AB0   -

 l CPU 412-1 6ES7 412-1XF01-0AB0   -

 l CPU 412-1 6ES7 412-1XF02-0AB0   -

 l CPU 412-1 6ES7 412-1XF03-0AB0   V1.1

 l CPU 412-1 6ES7 412-1XF03-0AB0   V1.2

 l CPU 412-1 6ES7 412-1XF03-0AB0   V3.0

 l CPU 412-1 6ES7 412-1XF03-0AB0   V3.1

 l CPU 412-1 6ES7 412-1XF04-0AB0   V4.0

 l CPU 412-1 6ES7 412-1XF04-0AB0   V4.1

 l CPU 412-1 6ES7 412-1XJ05-0AB0   V5.0

 l CPU 412-1 6ES7 412-1XJ05-0AB0   V5.1

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V1.1

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V1.2

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V3.0

 l CPU 412-2 DP 6ES7   412-2XG00-0AB0 V3.1

 l CPU 412-2 DP 6ES7   412-2XG04-0AB0 V4.0

 l CPU 412-2 DP 6ES7   412-2XG04-0AB0 V4.1

 l CPU 412-2 DP 6ES7   412-2XJ05-0AB0 V5.0

 l CPU 412-2 DP 6ES7   412-2XJ05-0AB0 V5.1

 l CPU 413-1 6ES7 413-1XG00-0AB0   -

 l CPU 413-1 6ES7 413-1XG01-0AB0   -

 l CPU 413-1 6ES7 413-1XG02-0AB0   -

 l CPU 413-2 DP 6ES7   413-2XG00-0AB0 -

 l CPU 413-2 DP 6ES7   413-2XG01-0AB0 -

 l CPU 413-2 DP 6ES7   413-2XG02-0AB0 -

 l CPU 414-1 6ES7 414-1XG00-0AB0   -

 l CPU 414-1 6ES7 414-1XG01-0AB0   -

 l CPU 414-1 6ES7 414-1XG02-0AB0   -
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 l CPU 414-2 DP 6ES7   414-2XG00-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG01-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG02-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V1.1

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V1.2

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V3.0

 l CPU 414-2 DP 6ES7   414-2XG03-0AB0 V3.1

 l CPU 414-2 DP 6ES7   414-2XG04-0AB0 V4.0

 l CPU 414-2 DP 6ES7   414-2XG04-0AB0 V4.1

 l CPU 414-2 DP 6ES7   414-2XJ00-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XJ01-0AB0 -

 l CPU 414-2 DP 6ES7   414-2XK05-0AB0 V5.0

 l CPU 414-2 DP 6ES7   414-2XK05-0AB0 V5.1

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V1.1

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V1.2

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V3.0

 l CPU 414-3 DP 6ES7   414-3XJ00-0AB0 V3.1

 l CPU 414-3 DP 6ES7   414-3XJ04-0AB0 V4.0

 l CPU 414-3 DP 6ES7   414-3XJ04-0AB0 V4.1

 l CPU 414-3 DP 6ES7   414-3XM05-0AB0 V5.0

 l CPU 414-3 DP 6ES7   414-3XM05-0AB0 V5.1

 l CPU 414-3 PN/DP 6ES7   414-3EM05-0AB0 V5.0

 l CPU 414-3 PN/DP 6ES7   414-3EM05-0AB0 V5.1

 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V2.1

 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V3.0

 l CPU 414-4 H 6ES7   414-4HJ00-0AB0 V3.1

 l CPU 414-4 H 6ES7   414-4HJ04-0AB0 V4.0

 l CPU 416-1 6ES7 416-1XJ00-0AB0   -

 l CPU 416-1 6ES7 416-1XJ01-0AB0   -

 l CPU 416-1 6ES7 416-1XJ02-0AB0   -

 l CPU 416-2 DP 6ES7   416-2XK00-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XK01-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V1.1

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V1.2

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V3.0

 l CPU 416-2 DP 6ES7   416-2XK02-0AB0 V3.1
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 l CPU 416-2 DP 6ES7   416-2XK04-0AB0 V4.0

 l CPU 416-2 DP 6ES7   416-2XK04-0AB0 V4.1

 l CPU 416-2 DP 6ES7   416-2XL00-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XL01-0AB0 -

 l CPU 416-2 DP 6ES7   416-2XN05-0AB0 V5.0

 l CPU 416-2 DP 6ES7   416-2XN05-0AB0 V5.1

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V1.1

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V1.2

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V3.0

 l CPU 416-3 DP 6ES7   416-3XL00-0AB0 V3.1

 l CPU 416-3 DP 6ES7   416-3XL04-0AB0 V4.0

 l CPU 416-3 DP 6ES7   416-3XL04-0AB0 V4.1

 l CPU 416-3 DP 6ES7   416-3XR05-0AB0 V5.0

 l CPU 416-3 DP 6ES7   416-3XR05-0AB0 V5.1

 l CPU 416-3 PN/DP 6ES7   416-3ER05-0AB0 V5.0

 l CPU 416-3 PN/DP 6ES7   416-3ER05-0AB0 V5.1

 l CPU 416F-2 6ES7 416-2FK02-0AB0   V3.1

 l CPU 416F-2 6ES7 416-2FK04-0AB0   V4.0

 l CPU 416F-2 6ES7 416-2FK04-0AB0   V4.1

 l CPU 416F-2 6ES7 416-2FN05-0AB0   V5.0

 l CPU 416F-2 6ES7 416-2FN05-0AB0   V5.1

 l CPU 416F-3 PN/DP   6ES7 416-3FR05-0AB0 V5.0

 l CPU 416F-3 PN/DP   6ES7 416-3FR05-0AB0 V5.1

 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.0

 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.1

 l CPU 417-4 6ES7 417-4XL00-0AB0   V1.2

 l CPU 417-4 6ES7 417-4XL00-0AB0   V3.0

 l CPU 417-4 6ES7 417-4XL00-0AB0   V3.1

 l CPU 417-4 6ES7 417-4XL04-0AB0   V4.0

 l CPU 417-4 6ES7 417-4XL04-0AB0   V4.1

 l CPU 417-4 6ES7 417-4XT05-0AB0   V5.0

 l CPU 417-4 6ES7 417-4XT05-0AB0   V5.1

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V1.1

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V2.0

 l CPU 417-4 H 6ES7   417-4HL00-0AB0 V2.1

 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V2.1
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 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V3.0

 l CPU 417-4 H 6ES7   417-4HL01-0AB0 V3.1

 l CPU 417-4 H 6ES7   417-4HL04-0AB0 V4.0

 

Supported OPC Data Access Specifications

The OPC servers you want to access to extract item information from   must be compliant with the fol-
lowing OPC Data Access Specification versions:

 l 1.0a

 l 2.0x

 

Supported Tag Types

Each of the supported target applications supports its own tag types.   The following sections describe 
the tag types that you can create to add   to your target application's database.

Supported iFIX Block Types

iFIX supports both standard datablocks and Database   Dynamos (loadable blocks). The following table 
lists the standard blocks   that are supported by the Discover and Auto Configure. 

Supported iFIX Standard Blocks

Block Type Description
AI Analog Input
AA Analog Alarm
AR Analog Register
AO Analog Output
DI Digital Input
DA Digital Alarm
DR Digital Register
DO Digital Output
TX Text

In Addition, if you are using the Allen-Bradley PLC-5/SLC 500/MicroLogix   Families Discovery Agent you 
can also use the iFIX Productivity Pack for   Allen-Bradley (ABP, ABT, and ABC blocks) that was spe-
cially created for   Allen-Bradley hardware and the ABR driver. You can use these blocks with   the cor-
responding  Allen-Bradley   Memory /File types.

You can use the Database Dynamos that are supplied with iFIX, or you   can create your own using the 
Build Dynamo Wizard.

NOTES:
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 l Database Dynamos must   exist in your iFIX application in order for them to appear in the Block   Type 
list on the Block Type and Scan Time Wizard.   For more information about Database Dynamos, refer to 
the Understanding   Database Dynamos topic in the iFIX electronic books 

 l If you are using an existing   iFIX database that contains datablocks of a type not supported by the   Dis-
cover and Auto Configure, those datablocks are not affected when you   add new datablocks with the 
Discover and Auto Configure. Any datablocks   already existing in your database are still supported by 
iFIX.

 

Setting up for Remote OPC Server Access

Before you can use the Discover and Auto Configure to extract OPC items   from and OPC server, you 
must make sure that your firewall settings are   correct, and that the DCOM settings for your operating 
system are correct.   You may not be able to access remote OPC servers if these settings are   not cor-
rectly set. For more detailed information on configuring these   settings, refer to the following topics:

 l Setting   Up Firewall for Discovery of Remote OPC Servers

 l Setting   Up DCOM for Discovery of Remote OPC Servers

 

Set Up the Firewall for Remote OPC Servers

If Firewall security is enabled you may need to modify or add items to the Exceptions list.

GE recommends that you enter these settings on   the local machine running the OPC Client, as well as 
on the remote machine   that has the OPC server you want to use.

 To modify Windows Firewall settings:

 1. Log into the Windows   operating system with an Administrator account.

 2. Open the Control   Panel and double-click Windows Firewall. The Windows Firewall dialog box   
appears. Make sure the "Allow a program through Windows firewall"   option is selected.

 3. Click the Exceptions   tab and make sure that the File and Printer Sharing check box is selected.   
The following figure shows an example of this dialog box in Microsoft     Windows XP.

26 © 2020 General Electric Company. All rights reserved.



 4. Click the Add Port   button. The Add a Port dialog box appears. The following figure shows   an 
example of this dialog box in Microsoft Windows XP.
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 5. In the Name field,   enter a name for the port.

 6. In the Port Number   field enter 135.

 7. Select the TCP option.

 8. Click OK to save   your changes.

The port name you entered is now listed   with its check box selected.

 9. Select the Add Program   button. The Add a Program dialog box appears. The following figure 
shows   an example of this dialog box in Microsoft Windows XP.
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 10. Click the Browse   button. A Browse dialog box appears.
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 11. Navigate to the System32   folder. This folder is found under the operating system folder (usually   
Windows or WINNT).

 12. In the System32 folder,   select the OPCENUM.exe file, and then click the Open button.

In the Add a Program dialog box the path   field displays the full path to, and including, the 
OPCENUM.exe file.
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 13. Click OK.

OPCENUM.exe should now be listed in the   Exceptions list with its check box selected.
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 14. Complete steps 9-13 for each OPC server that you   want to access.

NOTES:

 l You must also add the   GE OPC Client driver by adding the file OPCDrv.exe   into the Exceptions list.

 l If any OPC server that   you want to use is a dll surrogate (an in-process dll and not an .exe),   you must 
add \system32\dllhost.exe into the Exceptions list.

 l OPCENUM must reside on   the remote machine with the OPC server. While most OPC Server applic-
ations   install and register this file, some do not. You can download this file   from www.op-
cfoundation.org.   Currently it is contained within the OPC Core Components 2.00 Redistributable   
2.30.msi file. After you download OPCENUM, run the .msi file.

 

Setting Up DCOM for Discovery of Remote OPC Servers

The Discover and Auto Configure supports DCOM (Distributed   Component Object Model) to browse 
remote OPC Servers. If you want to grant   only certain users permission to launch or access the remote 
OPC servers,   you can use the Windows utility, DCOMCNFG.EXE for configuring DCOM applications.   
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DCOMCNFG.EXE is usually located in your operating system’s \system32 folder.

When OPC Servers register, they set up initial custom DCOM security   settings to enable users on the 
network to access and launch the Server.   On large networks, it is recommended that you modify these 
settings to   avoid confusion and inadvertent changes to a running OPC Server.

If Firewall security is enabled, you must also modify or add items to the Exceptions list.   Refer to Setting 
Up the Firewall for Discovery.

IMPORTANT NOTES:

 l It is recommended   that all Discover and Auto Configure users be members of the Administrators   
group. To facilitate this, it is recommended that you create a users group    to contain individual users 
that need to access remote OPC servers. 

For example, create a group named “DAC”   and add those users who will log into the operating sys-
tems and access   remote OPC servers. Add the users Tom, Denise, and Harry into the DAC   group. 
Each of these users will also be added into the Administrators   group. This DAC group should also con-
tain the following built-in security   principals: INTERACTIVE; NETWORK; SYSTEM.

 l To make any   OPC Client / OPC Server application work via DCOM, changes need to be   made on both 
sides, especially if you intend to use Asynchronous I/O communications.

 l OPCENUM must   reside on the remote machine with the OPC server. While most OPC Server   applic-
ations install and register this file, some do not. You can download   this file from www.op-
cfoundation.org.   Currently it is contained within the OPC Core Components 2.00 Redistributable   
2.30.msi file.  After   you download OPCENUM, run the .msi file.

 l This section   applies to OPC servers that need to use DCOM communications, regardless   of whether 
the OPC server uses Serial or Ethernet devices.

 l If OPC communications   is confined to a single machine (that is, using COM, but not DCOM), it   con-
tinues to work properly without making changes to DCOM settings.

 l If you do not   plan to use the Discover and Auto Configure to connect remotely to OPC   servers, then 
you may not need to change your DCOM settings.

 l If this is   the first time you are connecting to (or allowing connections from) other   machines on the net-
work, you must run the Windows Network Wizard (from   Start > Control Panel) to set up your computer 
to run on your network.   This allows you to share resources on your computer with other computers   on 
your network. It is recommended that you run the Network Setup Wizard   before modifying the DCOM 
settings.

DCOM Settings

The following procedures provide general guidelines for configuring   DCOM settings. 

 To launch the DCOM configurator:

 1. From the Start menu,    select or type Run. The Run dialog box appears.

 2. Type: dcomcnfg and   click OK.

The Component Services dialog box appears.

System-wide COM/DCOM Limits Settings

This procedure modifies the system-wide DCOM settings for the computer   on Windows Server 2008 
operating systems.   When these steps are implemented, they apply to all programs that use   
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COM/DCOM communications on the computer.

IMPORTANT:    Be careful when making any system-wide security changes. Any inadvertent   changes may 
affect the entire system and may cause some or all programs   to stop working.

 To update system-wide COM/DCOM limits   settings:

 1. On the Component   Services dialog box, expand Component Services, then expand the Com-
puters   item. 

 2. Right-click My Computer   and choose Properties. The My Computer Properties dialog box 
appears.

 3. Click the COM Security   tab. There are four permissions on this dialog box.

You may need to make changes to the Edit   Limits… for Access Permissions and Launch and 
Activation Permissions.

Do not change the Edit Default… settings,   since this will change the default settings for all pro-
grams and applications   running on the computer.

 4. Click Access Permissions   > Edit Limits… The Access Permission dialog box appears.

 i. Select the   user labeled ANONYMOUS LOGON, and then select the Allow check box for   
Remote Access.

NOTE:   This setting is necessary for applications that use OPCenum.exe to function   and also 
for some OPC Servers and OPC Clients that set their DCOM ‘Authentication   Level’ to ’None’ to 
allow anonymous connections. If you do not use such   applications, you may not need to 
enable remote access for anonymous logon   users.

 ii. Select the user   labeled Everyone, and then select the Allow check box for Remote 
Access.

IMPORTANT:   Since “Everyone” includes all authenticated users, it is recommended to   add 
these permissions to a smaller subset of users. One way of doing this   is to create a Group 
named “DAC” and add all user accounts to this Group   that will access any OPC server. Then 
substitute “DAC” everywhere that   “Everyone” appears in the entire DCOM configuration dia-
logs.

 iii. Click OK to close   the Access Permissions dialog box and return to the My Computer Prop-
erties   dialog box.

 5. Click Launch and   Activation Permissions > Edit Limits… The Launch Permission dialog   box 
appears.

For each user or group (preferably add the   “DAC” group) that needs to launch or activate the OPC 
server, or participates   in OPC / DCOM communications, make sure that the Local Launch, 
Remote   Launch, Local Activation, and Remote Activation check boxes are selected.

 6. Click OK to save   your changes, then click OK again to save and close the My Computer Prop-
erties   dialog box.

OPC Server-specific DCOM Settings

The following procedures detail the OPC server-specific COM/DCOM settings   on all supported Win-
dows operating systems. You must change the OPC server   settings so remote users can access the 
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OPC server as an OPC Data Access   Server. This procedure is also necessary for the GE   OPC Client 
driver to connect to, launch, configure, and start the remote   OPC servers.

It is recommended that all Discover and Auto Configure users be members   of the Administrators group.

IMPORTANT:   Since the “Everyone” group includes all authenticated users, it is recommended   to add these 
permissions to a smaller subset of users. 

It is recommended that you create a group to contain individual users that   need to access remote OPC serv-
ers. It is also recommended that all Discover   and Auto Configure users be members of the Administrators 
group.

For example, create a group named “DAC” and add those users who will log   into the operating systems and 
access remote OPC servers. Add the users   Tom, Denise, and Harry into the DAC group. Each of these users 
will also   be added into the Administrators group. This DAC group should also contain   the following built-in 
security principals: INTERACTIVE; NETWORK; SYSTEM.   Then substitute “DAC” everywhere that “Everyone” 
appears in the entire   DCOM configuration dialogs.

 To modify driver-specific DCOM settings:

 1. Access the DCOM configurator   (dcomcnfg.exe). The Component Services dialog box appears.

 2. Expand the Component   Services item, then expand the Computers item, and then expand the 
My   Computer item.

 3. Select the DCOM Config   object. A list of applications displays.

 4. Right-click the OPC   server you want to modify and choose Properties. The <Selected OPC   
Server> Properties dialog box appears.

 5. Click the General   tab. The Authentication Level should be set to “Default,” if it is not   already. This 
uses the default authentication rules that are set in the   system-wide DCOM settings.

 6. Click the Location   tab and make sure that the "Run Application on this computer"   check box is 
selected.

 7. Click the Security   tab and select the Customize option for each of the permissions in this   dialog 
box and edit them as described in the following steps.

 8. In the Launch and   Activation Permissions area, click Edit. The Launch and Activation Permission 
dialog   box appears.

 9. Click the Add button.   The Select Users or Groups dialog box appears. 

 10. Click the Advanced   Button. Another Select Users or Groups dialog box appears.

 11. Click the Find Now   button. In the search results, select the DAC group and click OK. The    Select 
Users or Groups dialog box displays the DAC group.  

 12. Click OK to return   to the Launch Permission dialog box. The DAC group is displayed in the   Group 
or user names list.

 13. Select the DAC group   and then select the Allow check boxes for Local Launch, Remote Launch,   
Local Activation, and Remote Activation permissions.

 14. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 15. In the Access Permissions   area, click Edit. The Access Permission dialog box appears.

 16. Click the Add button.   The Select Users or Groups dialog box appears. 
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 17. Click the Advanced   Button. Another Select Users or Groups dialog box appears.

 18. Click the Find Now   button. In the search results, select the DAC group and click OK. The   Select 
Users or Groups dialog box displays the DAC group.  

 19. Click OK to return   to the Access Permission dialog box. The DAC group is displayed in the   Group 
or user names list.

 20. Select the DAC group   and then select the Allow check boxes for Local Access and Remote 
Access   permissions.

 21. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 22. In the Configuration   Permissions area, click Edit. The Change Configuration Permission dialog   
box appears.

 23. Click the Add button.   The Select Users or Groups dialog box appears.

 24. Click the Advanced   Button. Another Select Users or Groups dialog box appears.

 25. Click the Find Now   button. In the search results, select the DAC group and click OK. The   Select 
Users or Groups dialog box displays the DAC group.  

 26. Click OK to return   to the Change Configuration Permission dialog box. The DAC group is dis-
played   in the Group or user names list.

 27. Select the DAC group   and then select the Allow check boxes for Full Control and Read per-
missions.

 28. Click OK to return   to the <Selected OPC Server> Properties dialog box.

 29. Click OK.

 30. Repeat steps 2 through   29 for each OPC server you need to access remotely.

 31. When you are done,   close the Component Services dialog box.
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Discover and Auto Configure Application

The Discover and Auto Configure application is composed of a system   tree and a spreadsheet, as well 
as toolbars and menus. Using each of these   components, you can search for and select the tags you 
want to add to   your target application database, as well as define valid tag names and   other tag features 
explicit to your target database. The following diagram   shows examples of the different components 
with tag information extracted   from a Siemens S7 project and iFIX as the target application.

Discover and Auto Configure Application

For more information about the standard toolbars and menus, refer to   Toolbars and Menus.

When you are working in the spreadsheet, you may find that the number   of extracted tags is too great to 
process in one sitting. Therefore, you   have the opportunity to save your work and exit the application, 
then   reopen the file and continue working on it at another time. If you make   changes to the spreadsheet 
(for example, create tag names), and do not   save your work before exiting the application, you are promp-
ted to save   your work as a .DAC file. For more information, see To   save a .DAC file. 

It is also possible that the source of your tag information has changed   since you performed the tag 
extraction. If this is the case, you have   the ability to rerun the Discovery Agent to extract the tag inform-
ation   from the source again. You can also use this feature to run the Discovery   Agent tool on a new 
source to display the differences between them. For   more information, see Rerunning   the Discovery 
Agent for a Siemens .S7P Project or Rerunning   the Discovery Agent for an OPC Server.

The Discover and Auto Configure provides a number of ways to search   for tags displayed in the spread-
sheet. Searching can be accomplished by   using one of the following features:
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 l Find

 l Filter

 l Sort

The System Tree

The system tree displays the tags extracted by the Discovery Agent.   The following diagram is an 
example of the system tree showing the tags   extracted from a Siemens S7 project file. Tags extracted 
by the Siemens   S7 Discovery Agent are categorized by the PLC programming software. The   project file 
is separated into two programs according to the CPU information.   Each program has a separate list for 
its symbols and datablocks. You can   select the CPU level to display all symbols and datablocks for that 
CPU,   or you can expand each level to select an individual symbol or datablock   to display in the spread-
sheet. 

Discover and Auto Configure System Tree for a Siemens   .S7P project

When you use the OPC Discovery Agent, the individual tag information   does not automatically display 
in the system tree; only the top level   initially displays. This is because when the Discover Agent 
retrieves   all of the data from a remote machine the process can be slow due to large   amounts of inform-
ation. As you expand each level, the OPC Discovery Agent   gets and displays the data for that level.

Remote OPC Server

The following figure displays an example of the system tree showing   the tags extracted from a remote 
OPC server.
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Discover and Auto Configure System Tree for a Remote OPC   Server

When the information for a remote OPC server displays in the system   tree, the remote machine name or 
TCP/IP address is appended to the OPC   server name. In the above example, 3.26.61.47   represents the 
TCP/IP address of the remote machine that the OPC server   resides on. When you use an OPC server 
located on a remote machine, the   system tree display uses the format <ipaddress>\<OPC server 
name>   or <machine name>\<OPC server name>. The remote machine name   or TCP/IP address is 
entered in the Select Local or Remote OPC Server   page of the Discovery Agent Selection Wizard. 

Local OPC Server

The following figure displays an example of the system tree showing   the tags extracted from a local 
OPC server.

Discover and Auto Configure   System Tree for a Local OPC Server

When the information for a local OPC server displays in the system tree,   the display format is 
<.>\<OPC server name>, where the period   (.) represents the local machine. The local machine is selec-
ted in the   Select Local or Remote OPC Server page of the Discovery Agent Selection   Wizard. 

The Spreadsheet

The Discover and Auto Configure spreadsheet displays the information   about the tags you selected to 
display. In this spreadsheet, you can view   the original tag information and select the individual tags you 
want to   add to your database. 

The spreadsheet is divided into two sections:

 l The   Discovery Agent section (left side of the spreadsheet)

 l The   Target Application section (right-side of the spreadsheet)

Each of these sections can be expanded and collapsed horizontally to   show or hide the columns of tag 
information. Click the >> Discovery Agent << cell or the   >> Target Application <<   cell to expand and col-
lapse these sections.
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The Discovery Agent Section

The Discovery Agent section of the spreadsheet displays the raw tag   information as it exists in the 
source. The displayed columns depend on   the source you extracted the tag information from. For more 
information,   see the specific Discovery Agent help topics.

The Select column of check boxes is available for all Discovery Agents   and target applications and 
affects both sections of the spreadsheet.   For more information, see Selecting   Tags to Add to the Data-
base.

The Status column is also available for all Discovery Agents. This column   name is different depending 
on the Discovery Agent you are using. When   you rerun the Discovery Agent on the same source, the 
status of the tags   is displayed as New, Not Found, Modified, or Blank. When you run the Discovery   
Agent on a new source, the status of all tags displays as New. The following   table describes each of the 
statuses.

Tag Statuses

Status Description

New

A new tag found by the Discovery Agent during the extraction process   
that did not previously exist in the current system tree. 

NOTE: If   you are running the Discovery Agent for the first time, all tag 
statuses   are displayed as New.

Not Found
The tag name, which previously existed in the current system tree, 
was   not found when the Discovery Agent was rerun on the source.

Modified
The tag, which previously existed in the current system tree, was 
found   when the Discovery Agent was rerun, but some or all of the 
tag's information   has been modified.

(Blank) No change.

NOTE: The status   field is for information purposes only and does not affect your ability   to add tags to or 
modify tags in the target database.

IMPORTANT: When   you are using the OPC or IGS Discovery Agent, the individual tag information   does not 
automatically display in the system tree; only the top level   initially displays. As you expand each level, the 
OPC or IGS Discovery   Agent gets and displays the data for that level. For this reason, the   OPC or IGS Item 
Status column may not display the status you expect.

Because the OPC or IGS Server is browsed only when requested (that is,   when a branch is expanded), when 
you rerun the OPC (or IGS) Discovery   Agent, the OPC or IGS Item Status field updates only those items 
already   displayed in the spreadsheet. When you browse for items for the very first   time, the status field will 
always display New, regardless of whether   there were changes to the OPC or IGS Server since the first time it 
was   browsed. Only those items already displayed in the spreadsheet show an   updated status.

The Target Application Section

The target application section of the spreadsheet displays the tag information   the way it will appear in 
your database. The information in these columns   is added automatically when you define the tags selec-
ted from the Discovery   Agent section or can be entered manually. The displayed columns depend   on the 
target application you are adding the tags to. For more information,   see the specific target application   
help topics.
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TIP: After you   have added the tag(s) to the database, view the status of the tags in   the target application sec-
tion. If the tags were successfully added to   the database, the Status column displays OK.   A small red square 
in a cell indicates bad data. Hover the mouse pointer   over the red square to display a pop-up explanation for 
the bad data.   You can double-click in the cell and change the bad data to valid data,   then update the tag 
information in the database.

Find

The Discover and Auto Configure provides a Find dialog box where you   can enter search criteria to help 
you find the tag(s) you want. You can   enter full words or enter a partial word in the search field; however,   
if you use only a partial word, such as "int", every instance   of that letter combination is located. 

You can search for the tag information that exactly matches the case   entered in the search criteria. For 
example, if you enter your search   criteria in lower case, the tag information must also be in lower case.   
You can also set the search criteria to match the contents of an entire   cell; only the cell that exactly 
matches the search criteria is found.

The Find feature saves the last 10 searches in a list box, allowing   you to repeat a search without having 
to re-enter your search criteria.   As you enter more search items and exceed the limit of 10, the last item   
on the list is deleted.

Filter

The Discover and Auto Configure provides a filter row in the spreadsheet   that removes items from the 
display that do not match the filter criteria.   You can filter tag information based on one column or any 
combination   of columns. Filtering begins as soon as you move the cursor to another   cell or press ENTER. 
Wildcards   are not supported.

Sort

The Discover and Auto Configure provides the ability to sort column   information displayed in the spread-
sheet by clicking on the column heading.   Sorting the displayed data can make it easier to understand 
and find what   you are looking for. All the data in the spreadsheet is sorted based on   the values of the first 
sort column. Within that sort, the data is sorted   based on the values of the second column, and so on.

You can sort the column values in both ascending and descending order.   Ascending is the default. 
Ascending means that numeric data is sorted   from lowest-to-highest and character data is sorted from 
A-to-Z. Descending   means the numeric data is sorted from highest-to-lowest value and character   data is 
sorted from Z-to-A.

Names that are surrounded by quotes are sorted separately from names   that do not have quotes. That 
is, when sorted in ascending order, names   with quotes are listed first; when sorted in descending order, 
names with   quotes are listed last.

You can also sort the Select column of check boxes to group all selected   tags together either at the 
beginning of the list (ascending) or at the   end (descending).

Number of Rows

The Number of Rows field displays the total number of rows currently   displayed in the spreadsheet. 
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Number of Selected Rows

The Number of Selected Rows field displays the total number of selected   rows.

 

Toolbars and Menus

The Discover and Auto Configure provides a standard toolbar   for performing common operations, as well 
as the standard menus.

In addition, the Discover and Auto Configure provides a search   feature and a right-click menu to make 
selections from. For more information   on the Find feature, see Discover and Auto Configure Application.

The Standard Toolbar

The following table describes the standard toolbar options. These options   are available with every Dis-
covery Agent and target application. 

Click this button... To...
Locate and load the .DAC file you want to work with.

Save the .DAC file that is currently open. If the   .DAC file does not 
already exist, the Save As dialog box appears.
Open the Save As dialog box where you can browse to   the location 
you want to save your .DAC file in.
Open the Find dialog box.

Open the Discover and Auto Configure online   Help.

Open the About dialog box.

To view the toolbar buttons specific to the iFIX target application,   see The iFIX   Wizards Toolbar and 
Right-Click Menu.

The Standard Menus

The following table describes the standard menu options. These options   are available with every Dis-
covery Agent and target application. 

Menu Name Menu Option Description

File

Open Open a browser dialog box to locate the 
.DAC file you want to open.

Save
Save the currently open .DAC file. If the 
.DAC file has not yet been   saved, the 
Save As dialog appears.

Save As
Open the Save As dialog box to save the 
spreadsheet as a .DAC file in   the desired 
location.

Export to .CSV
Open the Save As dialog box to save the 
spreadsheet as a .CSV file in   the desired 
location.
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Run Discovery Agent
Open the Discovery Agent Selection Wiz-
ard to extract tag information   from the 
same project file or a different project file.

Exit
Exit the Discover and Auto Configure 
application.

Edit

Select All Select all of the rows displayed in the 
spreadsheet.

Unselect All
Clear the Select check boxes of all the 
selected rows.

Clear Selected Rows

Clear the tag information from the target 
(right) side of the spreadsheet   for the 
selected rows.

NOTES:

 l Clearing rows   does not clear the 
rows on the Discovery Agent 
(left) side of the spreadsheet.

 l Clearing rows   does not delete 
the tags from the target data-
base.

Clear All Rows

Clear the tag information from the target 
(right) side of the spreadsheet   for all rows.

NOTES:

 l Clearing rows   does not clear the 
rows on the Discovery Agent 
(left) side of the spreadsheet.

 l Clearing rows   does not delete 
the tags from the target data-
base.

Find
Find the tag information using the spe-
cified search criteria.

View

Toolbars Select to show the toolbars. 
Select again to hide the toolbars.

NOTE: Toolbars   are displayed by default.

Status Bar

Select to show the status bar.
Select again to hide the status bar.

NOTE: The   status bar is displayed by 
default.

Target Column Settings

Select to show the column settings for:

 l Current Project

 l Default Settings   for iFIX

Help

Help Topics Open the Discover and Auto Configure 
online help.

About Discover and Auto Configure
Open the About Discover and Auto Con-
figure dialog box.
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The Right-Click Menu

The following table describes the common right-click menu options. These   options are available with 
every Discovery Agent and target application.   For information about the right-click menu options for your 
target application,   refer to the toolbar and right-click menu help topic for your specific   target application.

Choose this menu 
item...

To...

Select All Select all of the rows displayed in the spreadsheet.
Unselect All Clear the Select check boxes of all the selected rows.
Clear Selected Rows Clear the tag information from the target (right) side of the spread-

sheet   for the selected rows.

NOTES:

 l Clearing rows   does not clear the rows on the Discovery 
Agent (left) side of the spreadsheet.

 l Clearing rows   does not delete the tags from the target 
database.

Clear All Rows Clear the tag information from the target (right) side of the spread-
sheet   for all rows.

NOTES:

 l Clearing rows   does not clear the rows on the Discovery 
Agent (left) side of the spreadsheet.

 l Clearing rows   does not delete the tags from the target 
database.

 

Working with the Spreadsheet

Finding tags | Filtering   tags | Sorting tags | Selecting   tags to add to the database | Saving a .DAC file   | Open-
ing a .DAC file | Exporting   to a .CSV file | Viewing an exported .CSV file   on a non-English computer

The Discover and Auto Configure displays tag information in   a spreadsheet format that allows you to 
select the tags you want to add   to your target application database. The number of displayed rows can   
be extremely high; therefore, you can search for specific tags, filter   out unwanted tags, and sort each 
column to help you determine which tags   you want to add to your database. 

The Discover and Auto Configure also allows you to save the   spreadsheet you are working on so that 
you can open it at another time   and continue selecting and defining tags to add to your database.

 To find tags   in the spreadsheet:

 1. From the toolbar,   click the  Find in Spreadsheet button. The Find dialog box   appears.

 2. In the Find what   field, enter the search criteria to find the tag(s) you want.

 3. If applicable, select   the Match case and/or the Match entire cell contents check boxes.

 4. Click Find Next.   When an item that matches the search criteria is found, the spreadsheet   cell is 
selected. Continue clicking the Find Next button until you find   the item you want.
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 To filter tags   in the spreadsheet:

 1. Click any cell on   the Filter row to select the field. 

 2. Enter the characters   you want to use as the criteria to filter the items you want to work with   and 
move the cursor to another cell. The items that match the filter criteria   are displayed in the spread-
sheet. Wildcards are not supported.

NOTE:   When you are filtering in the Name column, you must enter the beginning   of the string exactly 
as it appears. For example, if the tag name is enclosed   in quotes you must start the filter with the open-
ing quotes. You do not   need to enter the entire string.

 To sort tags   in the spreadsheet:

 l Click a column heading   to sort the displayed items in ascending order. Click the column heading   
again to sort the items in descending order.

 To select tags   to add to the database:

 1. From the system tree,   expand the branch you want to select items from, then select the applic-
able   level to display the tags in the spreadsheet. For example, for Siemens   projects, you can;

 l Select the highest   level, which displays all symbols and datablocks. 

 l Select the Symbols   level to display the tags in that Symbol Table. 

 l Select the Datablocks   level to display a list of database blocks. 

IMPORTANT:   When you use the OPC Discovery Agent, the individual tag information does   not auto-
matically display in the system tree; only the top level initially   displays. This is because getting all of 
the data from a remote machine   can be slow due to large amounts of information. As you expand each 
level,   the OPC Discovery Agent gets and displays the data for that level.

 2. In the spreadsheet,   select the check box of each tag you want to add to the database. Each   row 
is highlighted in yellow to indicate that it has been selected.

TIPS:

 l To select all of the   displayed tags: 

 l Click the cell   in the upper left corner of the spreadsheet.

- Or -

 l Right-click anywhere   in the spreadsheet and choose Select All.

- Or -

 l From the Edit menu,   choose Select All.

- Or -

 l Press <CTRL + A>.

 l To select a consecutive   series of tags:

 l Select the first   row and drag the mouse pointer to the last tag  you   want to add that is 
displayed in the current window.

- Or -

 l Select the   check box of the first tag, hold down the SHIFT   key and then select the check 
box of the last tag you want to add.
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 l To select   a single row:

 l Select   the check box.

- Or - 

 l With the   cell cursor on the appropriate Select cell, press the space bar.

 l To remove   a single selection:

 l Select the   check box to clear it.

- Or -

 l With the   cell cursor on the appropriate Select cell, press the space bar to clear   it.

 l To clear   all selections, right-click anywhere in the spreadsheet and choose Unselect   All.

 l To clear   only the selected rows:

 l Right-click   anywhere in the spreadsheet and choose Clear Selected Rows. The inform-
ation   displayed in the selected rows on the target application side of the spreadsheet   is 
cleared.

- Or -

 l From   the Edit menu, choose Clear Selected Rows.

 l To clear   all rows:

 l Right-click   anywhere in the spreadsheet and choose Clear All Rows. The information   
displayed in all rows on the target application side of the spreadsheet   is cleared.

- Or -

 l From   the Edit menu, choose Clear All Rows.

 To save a .DAC   file:

 1. Extract the tag information   from your project file if you haven't already done so. The tag inform-
ation   is displayed in the spreadsheet.

 2. Click the Save As   button. The Save As dialog box appears.

 3. Browse to the directory   where you want the .DAC file to be located.

 4. In the File name   field, enter a unique name for your .DAC file and click Save.

 To open a .DAC   file:

 1. Launch the Discover and Auto Configure. Step 1 of the Discovery Agent Selection Wizard   
appears.

 2. Click Cancel to close   the wizard. The Discover and Auto Configure application appears   with no 
information displayed in the spreadsheet.

 3. Click the Open button.   The Open dialog box appears.

 4. Locate and select   the .DAC file you want to open and click Open. The .DAC file opens and   dis-
plays the tag information in the spreadsheet and system tree.

 To export to   a .CSV file:

 1. Extract the tag information   from your project file or OPC server if you haven't already done so. 
The   tag information is displayed in the spreadsheet.

 2. From the File menu,   choose Export to .CSV. The Save As dialog box appears.

46 © 2020 General Electric Company. All rights reserved.



 3. Browse to the directory   where you want the .CSV file to be located.

 4. In the File name   field, enter a unique name for your .CSV file and click Save.

NOTE:   Only the tags or OPC items that are currently displayed in the spreadsheet   are exported.

To view an   exported .CSV file on a non-English computer

IMPORTANT:   When you use the Discover and Auto Configure on a non-English   computer (that is, the 
operating system is any language other than English),   and you use MS Excel® to view your exported 
.CSV file, you must use Excel's   ImportData Wizard to import the file information, otherwise your data   
may not display properly.

The default English regional settings define the list separator as a comma   (,). Non-English regional 
settings may use a semicolon (;) as the list   separator. Excel uses commas as the list separator for 
.CSV (comma separated   value) files. Therefore, if you open the .CSV file directly in Excel on   a non-
English operating system, the data may not display properly.

 1. Start MS Excel.

 2. From the Data menu,   point to External Data and choose Import Text File. The Import Text File   
dialog box appears.

 3. From the Files of   Type list, choose All Files (*.*) to display the .CSV file you want to   view.

 4. Select the .CSV file   and click Import. The Text Import Wizard appears.

 5. Follow the steps   of the Text Import Wizard to define the list separator you want to use   (for 
example, comma). 

 6. Click Finish to import   the data from the .CSV file to Excel. The data is displayed in the Excel   
spreadsheet.

 

Discovery Agents

This section provides you with information about the Discovery Agents   that are available to you for 
extracting tag information. The following   is a list of Discovery Agents currently available:

 l Siemens   S7 Discovery Agent

 l OPC   Discovery Agent

 l Allen-Bradley   PLC-5/SLC 500/MicroLogix Families Discovery Agent

 l IGS - Industrial Gateway Server Discovery Agent

 

Discovery Agent Selection Wizard

The Discovery Agent Selection Wizard takes you through the steps required   to select a Discovery 
Agent and to extract the desired tag information   from the selected source; for example a Siemens S7P 
project file, or an   OPC server.

The following table lists the wizard steps and indicates whether they   are applicable to all Discovery 
Agents or if they are specific to only   one.
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Wizard Step Discovery Agent
Welcome All
Select a Discovery Agent All
Select a Local or Remote OPC 
Server

OPC Discovery Agent

Select an OPC Data Access Server OPC Discovery Agent
Select a Siemens S7P Project File Siemens S7 Discovery Agent
Select an RSLogix 5 or RSLogix 500 
.EAS File 

Allen-Bradley PLC-5/SLC 500/MicroLogix Families Dis-
covery Agent

IGS - Select an Action IGS - Industrial Gateway Server Discovery Agent
Select an RSLogix 5000 .L5K File IGS - Industrial Gateway Server Discovery Agent
Select a Device to Rescan IGS - Industrial Gateway Server Discovery Agent
Summary All

IMPORTANT:   If you do not have a specific Discovery Agent installed on your computer,   the steps that apply 
to that Discovery Agent are not available.

 

Discovery Agent Selection Wizard - Welcome

The Discovery Agent Selection Wizard - Welcome page introduces you to   the Discover and Auto Con-
figure. On this page you will find   the version number of the application, a brief introduction to the wizard,   
and copyright information.

Click Next to go to the Select a Discovery Agent   page.

 

Discovery Agent Selection Wizard - Select a Discovery   Agent

The Select a Discovery Agent page is where you select the Discovery   Agent you want to use for extract-
ing database tag, symbol, or OPC item   information. On this page you will find a list of the available Dis-
covery   Agents; that is, the Discovery Agents that are installed on your computer.   This page also 
displays a brief description of the Discovery Agent you   selected and the type of source that the tag or 
item information will   be extracted from (for example, a Siemens S7 project file, an OPC server,   an Allen-
Bradley PLC5 / SLC 500 / MicroLogix Families .EAS export file,   or an Allen-Bradley ControlLogix .L5K 
export file).

Click Next or click Back to return to the Welcome   page.

NOTE: Click the   Back button at any time to make changes to your selections.

 

OPC Discovery Agent

The OPC Discovery Agent examines an OPC server and finds all of the   items associated with that 
server. 
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You select the OPC Discovery Agent on the Select a Discovery Agent page   of the Discovery Agent 
Selection Wizard.

This section explains how to use the Discovery Agent Selection Wizard   to choose the OPC Discovery 
Agent and to extract item information from   an OPC server. When you click the Finish button at the end 
of the wizard   the item information is extracted from the selected OPC server, is read   by the Discover 
and Auto Configure, and is then displayed in   the spreadsheet.

The following table describes the columns exclusive to the OPC Discovery   Agent that are displayed in 
the spreadsheet.

Discovery Agent Section Columns

Column Name Description
Name The name of the item.
Fully Qualified ItemID 
(Comments)

The I/O address of the item, as returned by the OPC server. This 
information   can be copied to the Description field in the target applic-
ation section   of the spreadsheet .If the call fails, this field is left blank. 

The OPC client driver uses this field to auto-generate the I/O address   
field in the target database tab. If this field is blank, the driver will   not 
auto-generate the I/O address. You must then enter the I/O address   
manually.

OPC Tag Status The status of each item since it was last scanned from the OPC 
server.   For more information on tag statuses, see The   Discovery 
Agent Section in the Discover and Auto Configure Application topic.

After selecting the items you want to add to the database and using   the applicable iFIX wizards, the I/O 
addresses are automatically created   in the target application section of the spreadsheet. Using the 
server   and group you selected from the Driver Wizard, the application converts   each fully qualified item 
ID into an I/O address that can be used by iFIX   and the OPC Client driver.

 

Discovery Agent Selection Wizard - Select Local or Remote   OPC Server

The Select Local or Remote OPC Server page of the Discovery Agent Selection   Wizard is where you 
choose whether to access an OPC server on the local   machine or on a remote machine. If you choose to 
use a remote OPC server,   you can enter the name of the computer or its TCP/IP address, or you can   
browse your network for the machine that has the OPC server you want to   use.

If you select or enter a remote machine name, the machine name is validated   when you attempt to go to 
the next page in the wizard. If the remote machine   name is not valid, the following message displays:

The Remote Machine Name is not available.   Please select or enter a different Machine Name.

You must then select or enter a valid machine name to continue.

IMPORTANT:   You must have Administrative rights on the remote machine you are accessing   to be able to 
access the remote registry.

Click Next to go to the Select an OPC Data Access   Server page or click Back to return to the Select   a 
Discovery Agent page.

NOTE: Click the   Back button at any time to make changes to your selections.
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Discovery Agent Selection Wizard - Select an OPC Data   Access Server

The Select an OPC Data Access Server page lists all of the OPC servers   installed on the local or 
remote computer you selected on the previous   page. Choose the OPC server you want to extract item 
information from   and click OK to go to the Summary page.

If the OPC server you want to use is not listed, see the Browse   Failure section below for information on 
how to remedy the problem.

TIPS:

 l If you see the server you   want to use, you do not have to wait until the search is complete. You   can 
double-click the server or select it and press ENTER.

 l If you did not find the   OPC server you wanted and either installed it or corrected an issue of   remote 
access, you can click the Search Again button to start browsing   again.

 l You can click the Program   Name or Description column headers to sort in ascending or descending   
order.

Click Cancel to return to the Select Local or   Remote OPC Server page.

OPC Server Browse Methods

The Discover and Auto Configure uses various methods for browsing   local and remote machines for 
OPC servers.

Browsing OPC Servers on the Local Machine:

When browsing for OPC servers on the local machine, three methods are   used:

 l OPCEnum.exe - this   is a tool provided by the OPC Foundation that helps clients browse local   or 
remote machines. The Discover and Auto Configure installs   this utility on your local machine as 
part of the product installation.

 l Browse the Windows   Registry for OPC servers.

 l By CatagoryID - any   OPC 1.0 and 2.0 server that is registered with the Windows StdCom-
ponentCategoriesMgr   as an OPC 1.0 or OPC 2.0 CATID Server displays with this method. This   
method is not supported for use with remote machines.

Browsing OPC Servers on a Remote Machine:

When browsing for OPC servers on a remote machine, two methods are used:

 l OPCEnum.exe - this   is a tool provided by the OPC Foundation that helps clients browse local   or 
remote machines. The Discover and Auto Configure installs   this utility on your local machine as 
part of the product installation.

 l Browse the Windows   Registry for OPC servers. You must have Administrator rights to be able   to 
do this on a remote machine.

All servers that are found using any of the above methods are displayed   in this list.

Browse Failure
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If no servers were found on the machine, the message "No servers   were found on the machine" dis-
plays. You must then verify that either   the correct machine name/TCP/IP address was entered in the 
previous page   or that the OPC server(s) are correctly installed on the given machine.

If one or more methods fail, a message box displays indicating the methods   used and which ones suc-
ceeded or failed. It also displays an error message   indicating the reason for failure, as returned by the 
system. Any server(s)   found are listed. You can select a server from the list or remedy the   reason for the 
failure and rerun the search.

One possible remedy includes modifying your DCOM settings, even if your   OPC server is running loc-
ally. For more information about DCOM settings,   refer to Setting   Up DCOM for Discovery of Remote 
OPC Servers.

 

Extracting Item Information from an OPC Server

Extracting tag information from an OPC   server on the local machine | Extracting tag information   from an OPC 
server on a remote machine

It is possible that the source of your tag information has changed since   you performed the tag extraction. 
If this is the case, you can rerun the   OPC Discovery Agent to extract the tag information again. You can 
also   use this feature to run the OPC Discovery Agent on a new OPC server.

 To extract item   information from an OPC server on the local machine:

 1. Launch the Discover and Auto Configure application. The Discovery Agent Selection   Wizard 
appears.

 2. Click Next. The Select   a Discovery Agent page appears.

 3. From the list, select   the OPC Discovery Agent and click Next. The Select Local or Remote OPC   
Server page appears.

 4. Select Use Local   OPC Server to choose an OPC server that is installed on the local machine.

 5. Click Next. The Select   an OPC Data Access Server page appears, displaying a list of the OPC 
servers   installed on the local machine.

NOTE:   If no servers are found, verify that the OPC server(s) you want to access   are properly installed 
on the local machine. For more information, see   Discovery Agent Selection Wizard - Select an OPC   
Data Access Server.

 6. Choose the OPC server   you want to extract item information from and click OK. The Summary 
page   appears.

 7. Click Finish. The   OPC Discovery Agent extracts item information from the selected OPC server.   
When you select or expand a branch in the system tree, the item information   displays in the Dis-
cover and Auto Configure spreadsheet.

 To extract item   information from an OPC server on a remote machine:

IMPORTANT:   You must have Administrative rights on the remote machine you are accessing   to be able to 
access the remote registry.

 1. Launch the Discover and Auto Configure application. The Discovery Agent Selection   Wizard 
appears.
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 2. Click Next. The Select   a Discovery Agent page appears.

 3. From the list, select   the OPC Discovery Agent and click Next. The Select Local or Remote OPC   
Server page appears.

 4. Select Use Remote   OPC Server to select an OPC server that is installed on a remote machine.

 5. In the Remote machine   name or TCP/IP address field, enter the name or TCP/IP address of the   
remote computer.

- Or -

Browse the Network list and select the computer   name with the OPC server you want to use. 
The computer name automatically   appears in the Remote machine name or TCP/IP address 
field.

 6. Click Next. The Select   an OPC Data Access Server page appears, displaying a list of the OPC 
servers   installed on the remote machine.

NOTE:   If no servers are found, verify that the OPC server(s) you want to access   are properly installed 
on the local machine. For more information, see   Discovery Agent Selection Wizard - Select an OPC   
Data Access Server.

 7. Choose the OPC server   you want to extract item information from and click OK. The Summary 
page   appears.

 8. Click Finish. The   OPC Discovery Agent extracts item information from the selected OPC server.   
When you select or expand a branch in the system tree, the item information   displays in the Dis-
cover and Auto Configure spreadsheet.

 

Rerunning the Discovery Agent for an OPC Server

IMPORTANT: When   you are using the OPC Discovery Agent, the individual tag information   does not auto-
matically display in the system tree; only the top level   initially displays. As you expand each level, the OPC 
Discovery Agent   gets and displays the data for that level. For this reason, the OPC Item   Status column may 
not display the status you expect.

Because the OPC Server is browsed only when requested (that is, when a   branch is expanded), when you 
rerun the OPC Discovery Agent, the OPC Item   Status field updates only those items already displayed in the 
spreadsheet.   When you browse for items for the very first time, the status field will   always display New, regard-
less of whether there were changes to the OPC   Server since the first time it was browsed. Only those items 
already displayed   in the spreadsheet show an updated status.

 To rerun the Discovery Agent:

 1. Launch the Discover   and Auto Configure application and follow the Discovery Agent Selection   
Wizard steps to extract item information from the OPC server. The item   information is displayed 
in the Discovery Agent section of the spreadsheet.   

NOTE:   The OPC Item Status column displays New for all rows.

 2. Perform any applicable   tasks you need to in the spreadsheet, including selecting   tags, defining 
tags for the target database, saving   a .DAC file, adding tags to the database, and so on.

 3. From the File menu,   choose Run Discovery Agent. You are prompted with the question "Do   you 
want to run the Discovery Agent again?"

52 © 2020 General Electric Company. All rights reserved.



 4. Click Yes. The Discovery   Agent Selection Wizard opens at the Select Local or Remote OPC 
Server   page with the previous selections displayed; that is, if you had previously   browsed an 
OPC server on a remote machine, the Remote Machine option is   selected and the machine name 
is displayed.

 5. Leave your selection   as is, or change it to the other option and click Next to go to the Select   an 
OPC Data Access Server dialog box..

 6. Select an OPC server   and click OK to go to the Summary page. You can select the same OPC 
server   or a different one.

 7. On the Summary page,   click Finish. The item information is extracted from the OPC server 
again.   For each item that is being browsed again, the Discovery Agent tool compares   the item 
information from the new extraction with the items displayed   in the spreadsheet and then updates 
the spreadsheet.

The status of each item is updated in the   spreadsheet. The status can be New, Modified, Not 
Found, or blank (that   is, no change). For more information, refer to the Discovery   Agent Section 
of the Discover   and Auto Configure Application topic.

 8. Click the OPC Item   Status column to sort the statuses and view the differences.

 

Siemens S7 Discovery Agent

The Siemens S7 Discovery Agent examines a project file with a .S7P extension and finds all the Sym-
bols   and Datablocks for that project. A .S7P project file is saved from the   Siemens Step 7 programming 
software, version 5.4.

NOTE: The Step   7 project file (.s7p) and all files associated with the Step 7 project,   including all the other files 
in the sub-directories within the project   directory, must be accessible to the Siemens S7 Discovery Agent and 
have   the Read/Write/Modify/Full Control option enabled. 

You select the Siemens Discovery Agent on the Select a Discovery Agent   page of the Discovery Agent 
Selection Wizard.

This section tells you how to use the Discovery Agent Selection Wizard   to choose the Siemens Dis-
covery Agent and to extract database tag information   from a Siemens .S7P project file. When you click 
the Finish button at   the end of the wizard the database tag information is extracted from the   selected pro-
ject file, is read by the Discover and Auto Configure,   and then displayed in the spreadsheet.

The following table describes the columns exclusive to the Siemens S7   Discovery Agent that are dis-
played in the spreadsheet.

Discovery Agent Section Columns

Column Name Description
Name The name of the tag.
Address The I/O address of the tag.
Comment Descriptive information about the tag.
Type The database tag type assigned to the tag.
Siemens Tag Status The status of each tag since it was last scanned from the .s7p project   

file. For more information on tag statuses, see The   Discovery Agent 
Section in the Discover and Auto Configure Application topic.
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Discovery Agent Selection Wizard - Select a Siemens   .S7P Project

On the Select a Siemens .S7P Project page, you must select the appropriate   Step 7 project file (.s7p) 
that you want to extract tag information from.   You can either enter the full path of the project file's loc-
ation, or   click the  Browse button to search for the project file   you want to use.

Click Next to go to the Summary page or click   Back to return to the Select a Discovery Agent   page.

NOTE: Click the   Back button at any time to make changes to your selections.

IMPORTANT: The   Step 7 project file (.s7p) and all files associated with the Step 7 project,   including all the 
other files in the sub-directories within the project   directory, must be accessible to the Siemens S7 Discovery 
Agent. Project   files must have the Read/Write/Modify/Full Control option enabled; otherwise,   the project can-
not be opened (whether the project files reside on a local   or remote computer).

 

Extracting Tag Information From a Siemens .S7P Project   File

It is possible that the source of your tag information has changed since   you performed the tag extraction. 
If this is the case, you can rerun the   Siemens S7 Discovery Agent to extract the tag information again. 
You can   also use this feature to run the Siemens S7 Discovery Agent tool on a   new source file.

 To extract tag information from a   Siemens .S7P project file:

 1. Launch the Discover and Auto Configure application. The Discovery Agent Selection   Wizard 
appears.

 2. Click Next. The Select   a Discovery Agent page appears.

 3. From the list, select   the Siemens S7 Discovery Agent and click Next. The Select a Siemens S7P   
Project page appears.

 4. Enter the full path   and file name of the .S7P project file you want to extract tag information   from, 
or click the  Browse button to locate the file you   want.

NOTE:   If the project files are located on a shared (mapped) drive on a remote   machine, that shared 
drive must have the allow Read/Write/Modify/Full   Control option enabled, otherwise the project cannot 
be opened.

 5. Click Next. The Summary   page appears displaying a summary of the selections you made in the 
previous   wizard pages.

 6. Click Finish. The   Siemens S7 Discovery Agent extracts all of the tag information from the   selec-
ted project file and displays it in the Discover and Auto Configure application.

 

Rerunning the Discovery Agent for a Siemens .S7P Project

 To rerun the Discovery Agent:

 1. Launch the Discover and Auto Configure application and follow the Discovery Agent   Selection 
Wizard steps to extract tag information from the source file.   The tag information displays in the 
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Discovery Agent section of the spreadsheet.   

NOTE:   The Tag Status column displays New for all rows.

 2. Perform any applicable   tasks you need to in the spreadsheet, including selecting   tags, defining 
tags for the target database, saving   a .DAC file, adding tags to the database, and so on.

 3. From the File menu,   choose Run Discovery Agent. You are prompted with the question "Do   you 
want to run the Discovery Agent again?"

 4. Click Yes. The Discovery   Agent Selection Wizard opens at the Select a Siemens .S7P Project 
File   page and the location of the current source file is displayed.

 5. Click Next to go   to the Summary page, and then click Finish. The tag information is extracted   
from the source file again. The Discovery Agent tool compares the tag   information from the new 
extraction with the tags displayed in the spreadsheet   and then updates the spreadsheet.

The status of each tag is updated in the   spreadsheet. The status can be New, Modified, Not 
Found, or blank (that   is, no change). For more information, refer to the Discovery   Agent Section 
of the Discover and Auto Configure Application topic.

 6. Click the Tag Status   column to sort the statuses and view the differences.

 

Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery   Agent

The Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery Agent   examines an exported address 
and symbol description file with an .EAS   extension and finds all the symbols defined for a device. An 
.EAS file   is exported from the Rockwell RSLogix 5 or RSLogix 500 programming software,   containing 
address and symbol definition information in an RSLogix project.

You select the Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery   Agent on the Select a Dis-
covery Agent page of the Discovery Agent Selection   Wizard. 

This section tells you how to use the Discovery Agent Selection Wizard   to choose the Allen-Bradley 
PLC-5/SLC 500/MicroLogix Families Discovery   Agent and how to extract symbol information from a 
Rockwell RSLogix .EAS   file. When you click the Finish button at the end of the wizard the symbol   
information is extracted from the selected file, is read by the Discover and Auto Configure application, 
and then displayed in the spreadsheet.

The following table describes the columns exclusive to the Allen-Bradley   PLC-5/SLC 500/MicroLogix 
Families Discovery Agent that are displayed in   the spreadsheet.

Discovery Agent Section Columns

Column Name Description
Name The name of the symbol.
Address The I/O address of the symbol.
Comment Descriptive information about the symbol.
Type The database tag type assigned to the symbol.
File Type The file type associated with the symbol.
Allen-Bradley PLC 
Tag Status

The status of each symbol since it was last scanned from the .EAS 
file.   For more information on tag statuses, see The Discovery Agent 
Section   in the Discover and Auto Configure Application topic.
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Supported File Types

The following table describes the file types supported by the Allen-Bradley   PLC-5/SLC 500/MicroLogix 
Families Discovery Agent.

Discovery Agent Supported File Types

Type Description
A ASCII
B Binary
BT Block Transfer
C Counter
CT ControlNet Transfer
D BCD
F Float
I Input
MG Message Control
N Integer
O Output
PD PID control
R Control
S Status
ST String
R Timer

IMPORTANT: 

 l Generally,   only the file or memory types supported by the GE ABR Driver v7.2x   or above are sup-
ported by this Discovery Agent. 

 l The Discovery   Agent will not perform any Address Range checking. You need to make sure   that the 
imported addresses match those in the PLC.

 l The Discovery   Agent imports all the file or memory types in the above table, regardless   of the type of 
PLC (for example, PLC-5, SLC 500, or MicroLogix) that you   configured. The PLC may only support a 
sub-set of the above file or memory   types. Therefore, when configuring your driver, you need to map it 
to   the device with the appropriate PLC type. Otherwise, you may get errors   when trying to add tags to 
iFIX or the driver configurations.

 

Discovery Agent Selection Wizard - Select an RSLogix   5 or RSLogix 500 .EAS File

On the Select an RSLogix 5 or RSLogix 500 .EAS File page, you must select   the appropriate RSLogix 
exported address and symbol definition file (.EAS)   that you want to extract symbol information from. 
You can either enter   the full path of the file's location, or click the  Browse   button to search for the file 
you want to use.

You also need to enter a name for the PLC you are extracting the symbol   information for.  The   wizard 
uses this name to determine whether the PLC is a new device being   imported into the project, or it is a 
device already existing in the project.    The latter   case can happen if you re-run the discovery agent to 
update an existing   device.  You   can conveniently select the name from the drop-down list if it is an exist-
ing   device in the project.
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NOTE: You can   extract symbols from only one EAS file a time.  To   extract symbols from more devices, rerun 
the Discovery Agent.

Click Next to go to the Summary page or click   Back to return to the Select a Discovery Agent   page.

NOTE: Click the   Back button at any time to make changes to your selections.

 

Extracting Tag Information from an RSLogix .EAS File

It is possible that the source of your symbol information has changed   since you performed the symbol 
extraction. If this is the case, you can   rerun the Allen-Bradley PLC-5/SLC 500/MicroLogix Families 
Disovery Agent   to extract the symbol information again. You can also use this feature   to run the Allen-
Bradley PLC-5/SLC 500/MicroLogix Families Disovery Agent   tool on a new source file.

 To extract symbol information from   an RSLogix .EAS file:

 1. Launch the Discover and Auto Configure application. The Discovery Agent Selection   Wizard 
appears.

 2. Click Next. The Select   a Discovery Agent page appears.

 3. From the list, select   the Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery Agent and   
click Next. The Select an RSLogix .EAS File page appears.

 4. Enter the full path   and file name of the .EAS file you want to extract symbol information   from, or 
click the  Browse button to locate the file you   want.

 5. Enter or select a   name for the device.

 6. Click Next. The Summary   page appears displaying a summary of the selections you made in the 
previous   wizard pages.

 7. Click Finish. The   Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery Agent extracts   
all of the symbol information from the selected .EAS file and displays   it in the Discover and Auto 
Configure application.

 

Rerunning the Discovery Agent for an RSLogix .EAS Project

 To rerun the Discovery Agent:

 1. Launch the Discover and Auto Configure application and follow the Discovery Agent   Selection 
Wizard steps to extract symbol information from the source file.   Or, you can Open an existing 
DAC Project File for the Allen-Bradley PLC-5/SLC   500 /MicroLogix Discovery Agent that you pre-
viously saved.

The symbol information displays in the Discovery   Agent section of the spreadsheet. 

NOTE:   The Tag Status column displays New for all rows.

 2. Optionally, perform   any applicable tasks you need to in the spreadsheet, including selecting   tags, 
defining tags for the target database, saving   a .DAC file, adding tags to the database, and so on.

 3. From the File menu,   choose Run Discovery Agent. You are prompted with the question "Do   you 
want to run the Discovery Agent again?"
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 4. Click Yes. The Discovery   Agent Selection Wizard opens at the Select an RSLogix .EAS file 
page and   the location of the current source file is displayed.

 5. Click Next to go   to the Summary page, and then click Finish. The symbol information is   extracted 
from the source file again. The Discovery Agent tool compares   the symbol information from the 
new extraction with the symbols displayed   in the spreadsheet and then updates the spreadsheet.

The status of each tag is updated in the   spreadsheet. The status can be New, Modified, Not 
Found, or blank (that   is, no change). For more information, refer to the Discovery   Agent Section 
of the Discover and Auto Configure Application topic.

 6. Click the Tag Status   column to sort the statuses and view the differences.

 

IGS - Industrial Gateway Server Discovery Agent

The IGS - Industrial Gateway Server Discovery Agent examines an exported   address and tag descrip-
tion file with an .L5K file extension and finds   all the tags defined for a device. An .L5K file is exported 
from the Rockwell   RSLogix 5000 programming software, containing address and tag information   in an 
RSLogix project for a ControlLogix PLC.

You select the IGS - Industrial Gateway Server Discovery Agent on the   Select a Discovery Agent page 
of the Discovery Agent Selection Wizard.   

This section tells you how to use the Discovery Agent Selection Wizard   to choose the IGS - Industrial 
Gateway Server Discovery Agent and how   to extract symbol information from a Rockwell RSLogix .L5K 
file for ControlLogix   PLCs. When you click the Finish button at the end of the wizard the symbol   inform-
ation is extracted from the selected file, is read by the Discover   and Auto Configure, and then displayed 
in the spreadsheet.

The following table describes the columns exclusive to the IGS - Industrial   Gateway Server Discovery 
Agent that are displayed in the spreadsheet.

Discovery Agent Section Columns

Column Name Description
Name The name of the tag.
IGS Item ID The item ID of the tag.
Description Descriptive information about the tag.
Data Type The IGS data type assigned to the tag.
Status The status of each tag since it was last scanned from the .L5K file.   

For more information on tag statuses, see The Discovery Agent sec-
tion   in the Discover   and Auto Configure Application topic.

IMPORTANT: 

 l This Discovery   Agent supports only the file or memory types supported by the GE   IGS driver version 
7.41 and 7.51 or greater. 

 l The Discovery   Agent does not perform any Address Range checking. You need to make sure   that the 
imported addresses match those in the PLC.

 l The Discovery   Agent imports all the file or memory types that are supported by the IGS   driver. The 
PLC may only support a sub-set of the memory types. Therefore,   when configuring your driver, you 
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need to map it to the device with the   appropriate PLC type. Otherwise, you may get errors when trying 
to add   tags to iFIX or the driver configurations.

 l The IGS   driver configuration tags displayed in the tree view and spreadsheet are   not limited to Con-
trolLogix PLCs. You can browse all the configured channels   and devices in your IGS Server.

 l When you   are using the IGS Discovery Agent, the individual tag information does   not automatically dis-
play in the system tree; only the top level initially   displays. As you expand each level, the IGS Dis-
covery Agent gets and displays   the data for that level. For this reason, the IGS Item Status column may   
not display the status you expect.

 l Because   the IGS Server is browsed only when requested (that is, when a branch   is expanded), when 
you rerun the IGS Discovery Agent, the IGS Item Status   field updates only those items already dis-
played in the spreadsheet. When   you browse for items for the very first time, the status field will always   
display New, regardless of whether there were changes to the IGS Server   since the first time it was 
browsed. Only those items already displayed   in the spreadsheet show an updated status.

 

Discovery Agent Selection Wizard - Select an Action

On the Select an Action page, you must select the appropriate action:

 l Import   New RSLogix 5000 .L5K File –   if you want to add a new device and import an .L5K file.

 l Browse   Current IGS Driver Configuration –   if you want to browse existing IGS driver con-
figurations. In this case,   you do not add or rescan the existing devices.

NOTE:   The GE IGS driver version 7.51 has the ability to add additional   protocols when setting up the 
IGS driver configuration.  When   you browse your current IGS driver configuration to populate the DAC 
items,   the browse now includes items in the IGS driver configuration created   under any of these addi-
tional protocols.

 l Rescan   Existing Device Tags from .L5K File –   if you want to rescan an existing device. This 
triggers an IGS driver   database tag update for the existing device that you select. 

Click Next to go to the next page, or click Back to return to the previous   page.

NOTE: Click the   Back button at any time to  go   back to make changes to your previous selections.

 

Discovery Agent Selection Wizard - Select an RSLogix   5000 .L5K File

On the select an RSLogix 5000 ControlLogix Ethernet .L5K File page,   you must select the appropriate 
RSLogix exported address and tag definition   file (.L5K) that you want to get tag information from. You 
can either   enter the full path of the file's location, or click the  Browse button to search for the file you 
want to use.

After you enter the name for the .L5K file, the Device name, IP address,   and slot number from the .L5K 
file automatically appear in this dialog   box, if available. By default, the Controller name found in the .L5K 
file   is used as your device name.

If these are not available or you want to change these values, you need   to manually enter the name of 
the PLC or Device you are extracting the   tag information for, along with the IP address and the CPU slot 
number.   
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Select the ControlLogix Ethernet channel from the drop-down list. If   you want to add a new ControlLogix 
Ethernet channel, type in the channel   name. A new channel is added to the IGS configuration. The 
Device or PLC   that you enter is added to this channel.

NOTES:

 l You can   extract tags from only one .L5K file a time. To extract tags from more   devices, rerun the Dis-
covery Agent.

 l If you   have multiple Ethernet modules in your PLC project, the Discovery Tool   obtains the IP address 
of the first ENET module found in your .L5K file.   If it cannot find the IP address in your .L5K file, this 
field remains   blank. You must then manually enter the IP address for proper communications   to your 
PLC. 

 l Similarly,   if you have multiple CPU modules in your PLC project, the Discovery Tool   obtains the slot 
number for the first controller module found in your   .L5K file.

 l In the   Channel drop-down list, the Discovery Tool displays only the channels   in the IGS that have 
been configured for ControlLogix Ethernet driver   communications.

Click Next to go to the Summary page or click   Back to return to the previous page.

NOTE: Click the   Back button at any time to make changes to your selections.

 

Discovery Agent Selection Wizard - Select a Device to   Rescan

On the Select a Device to Rescan page, you must select the channel and   device name from the drop-
down lists. The path for the .L5K file name    (if available)   associated with the selected device auto-
matically appears in the Path   and L5K File Name field. 

This triggers the IGS driver to perform a database tag update for the   existing device that you select. 

NOTE: You can   rescan tags from only one .L5K file a time. To rescan tags from more devices,   rerun the Dis-
covery Agent.

Click Next to go to the Summary page or click   Back to return to the previous page.

 

Extracting Tag Information from an RSLogix  5000   ControlLogix .L5K File

Use this feature to run the IGS - Industrial Gateway Server Discovery   Agent tool on a new source file.

 To extract tag information from an   RSLogix 5000 ControLogix .L5K file:

 1. Launch the Discover   and Auto Configure application. The Discovery Agent Selection Wizard 
appears.

 2. Click Next. The Select   a Discovery Agent page appears.

 3. From the list, select   the IGS - Industrial Gateway Server Discovery Agent and click Next. The   
Select an Action page appears.

 4. Select the Import   New RSLogix 5000 .L5K File option and click Next. The Select an RSLogix   
5000 .L5K File page appears.

 5. Enter the full path   and file name of the .L5K file you want to extract symbol information   from, or 
click the  Browse button to locate the file you   want.
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 6. Enter a name for   the device if it does not automatically appear when you enter or select   the .L5K 
file. By default, the Controller name found in the .L5K file   is used as your device name.

 7. Enter the Device   IP address and CPU slot number if it does not automatically appear when   you 
enter or select the .L5K file. By default, the IP Address found for   the first ENET module will be 
used as your IP address. Similarly, by default,   the slot number for the first controller module 
found in your .L5K file   will be used as the CPU slot number.

 8. Select a ControlLogix   channel from the drop-down list.

 9. Click Next. The Summary   page appears displaying a summary of the selections you made in the 
previous   wizard pages.

 10. Click Finish. The   IGS - Industrial Gateway Server Discovery Agent extracts all of the symbol   
information from the selected .L5K file and displays it in the Discover   and Auto Configure applic-
ation.

 

Rerunning the Discovery Agent for the IGS Driver for   an RSLogix .L5K Project

It is possible that the source of your tag information has changed since   you performed the tag extraction. 
If this is the case, you can rerun the   IGS - Industrial Gateway Server Discovery Agent to extract the tag 
information   again. You can also use this to add a new device.

IMPORTANT: When   you are using the IGS Discovery Agent, the individual tag information   does not auto-
matically display in the system tree; only the top level   initially displays. As you expand each level, the IGS Dis-
covery Agent   gets and displays the data for that level. For this reason, the IGS Item   Status column may not 
display the status you expect.

Because the IGS Server is browsed only when requested (that is, when a   branch is expanded), when you 
rerun the IGS Discovery Agent, the IGS Item   Status field updates only those items already displayed in the 
spreadsheet.   When you browse for items for the very first time, the status field will   always display New, regard-
less of whether there were changes to the IGS   Server since the first time it was browsed. Only those items 
already displayed   in the spreadsheet show an updated status.

 To rerun the Discovery Agent:

 1. Launch the Discover   and Auto Configure application and follow the Discovery Agent Selection   
Wizard steps to extract tag information from the source file. Or, you   can open an existing DAC 
Project File for the IGS - Industrial Gateway   Server Discovery Agent  that   you previously saved.

The tag information displays in the Discovery   Agent section of the spreadsheet. 

NOTE:   The Tag Status column displays New for all rows.

 2. Optionally, perform   any applicable tasks you need to in the spreadsheet, including selecting   tags, 
defining tags for the target database, saving   a .DAC file, adding tags to the database, and so on.

 3. From the File menu,   choose Run Discovery Agent. You are prompted with the question "Do   you 
want to run the Discovery Agent again?"

 4. Click Yes. The Discovery   Agent Selection Wizard opens at the Select an Action page.

 5. If you want to rescan   an existing device, select the Rescan Existing Device Tags from .L5K File   
option. If you want to add a new device, select the Import New RSLogix   5000 .L5K Configuration 
File option.
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 6. Click Next to go   to the Summary page, and then click Finish. The tag information is extracted   
from the source file again. The Discovery Agent tool compares the tag   information from the new 
extraction with the symbols displayed in the   spreadsheet and then updates the spreadsheet.

The status of each tag is updated in the   spreadsheet. The status can be New, Modified, Not 
Found, or blank (that   is, no change). For more information, refer to the Discovery   Agent Section 
of the Discover   and Auto Configure Application topic.

 6. Click the Tag Status   column to sort the statuses and view the differences.

 

Discovery Agent Selection Wizard - Summary

The Summary page displays a summary of the selections you made on the   previous wizard pages, as 
well as the target application with the database   that the tags or OPC items will be added to.

Click Finish to complete the Discovery Agent Selection Wizard, or click   Back to return to the previous 
page.

NOTE: Click the   Back button at any time to make changes to your selections.

When you click Finish, the Discover and Auto Configure extracts   the tag or item information you want 
and displays it in the left side   of the spreadsheet. You are now ready to select the tags or items you   want 
to add to the database and to define the information so that the   selected driver can use it.
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Target Applications

This section provides you with information about the target applications   that are available to you to add 
the selected database tags to. Each target   application has its own database to store its database tags 
and their   information. The following are the target applications currently available:

 l iFIX

 

iFIX

iFIX is a client/server-based solution, offering   scan-driver operations and enhanced operations in large 
process-oriented   environments.

The Discover and Auto Configure application provides the ability   to add and remove iFIX database 
columns displayed in the target application   side of the spreadsheet. You can even rename iFIX column 
names. For more   information, refer to the Modifying iFIX Columns   in the Spreadsheet section. 

Alternatively, a text file, called iFIXColumns.txt is installed with   the application and is located in the 
same directory as the application.   This file also contains the default iFIX database columns and descript-
ive   information to help you add columns to the spreadsheet. You can add additional   columns or you can 
remove columns, including the default columns, by deleting   them or simply hiding them by using this 
text file as well. For more information   about using the iFIXColumns.txt file, refer to the Using   the 
iFIXColumns.txt File to Modify iFIX Columns in the Spreadsheet   section.

NOTES:

 l If the Discover and Auto Configure application is open when you make a change to   the 
iFIXColumns.txt file, you must exit and restart the application for   the changes to take effect.

 l If you delete the iFIXColumns.txt   file, the application will regenerate the file with the default columns.

The following table describes the default iFIX columns   displayed in the target application section of the 
spreadsheet. 

HMI/SCADA Section Default Columns

Column Name Description
Tag Name The name of the tag as it will appear in your database..
Type The assigned database block type. For more information, see Block   

Type and Scan time Wizard.
Description Descriptive information about the tag. This information can be added   

manually or copied from the Comment column. For more information, 
see   Tag Name and Description Wizard.

Scan Time The scan time assigned to the tags. For more information, see Block   
Type and Scan Time Wizard.

Driver The selected driver that will use the tags added to the database. For   
more information, see Driver Wizard.

I/O Address The I/O Address automatically assigned to the tag by the selected 
driver   device.

H/W The hardware option for the tag. You manually enter this information.   
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Depending on the driver you are using, the Hardware option field may 
be   assigned automatically for I/O addresses with certain datatypes. 
Hardware   options must match the hardware options available in the 
database for   the driver that you selected.

Signal Cond The signal conditioning option for the tag. You manually enter this   
information. Depending on the driver you are using, the signal con-
ditioning   field may be assigned automatically for I/O addresses with 
certain datatypes.   Signal conditioning options must match the signal 
conditioning options   available in the database for the driver that you 
selected.

Last Action Status Flag that indicates whether the tag was successfully added to your 
database.

For more information, refer to the iFIX electronic   books.

 

The iFIX Wizards Toolbar and Right-Click Menu

The iFIX Wizards Toolbar can be used in two ways. You can run the dialog   boxes consecutively as a 
wizard with the click of a single button, or   you can open each dialog box separately. When you run the 
dialogs as a   wizard, you are provided with Next and Back buttons to move forward and   backward 
through the dialog boxes. When you open an individual dialog   box, you simply click OK to save your 
changes and close the dialog box.

iFIX Wizards Toolbar

The iFIX Wizards toolbar buttons are available only when your target   application database is iFIX and 
you have selected at least one   tag in the spreadsheet.

Click this button... To...
Launch the series of dialog boxes starting with the Tag Name and 
Description   Wizard. When you are finished with each Wizard, click 
Next. 
Open the Tag Name and Description Wizard.

Open the Block Type and Scan Time Wizard.

Open the Driver Wizard.

Add the selected tags to the iFIX Process Database.

Apply the changes you make to the tag information   in the spreadsheet 
to the tag in the iFIX Process Database.

iFIX Right-Click Menu

The iFIX right-click menu options are available whenever your target   application database is iFIX.

Choose this menu 
item...

To...

iFIX - All Wizards Launch the series of dialog boxes starting with the Tag Name and 
Description   Wizard. When you are finished with each wizard, click 
Next. 
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iFIX - Tag Name Wizard Open the Tag Name and Description Wizard.
iFIX - Block Type Wizard Open the Block Type and Scan Time Wizard.
iFIX - Driver Wizard Open the Driver Wizard.
Add to iFIX Add the selected tags to the iFIX Process Database.
Modify in iFIX Apply the changes you make to the tag information in the spread-

sheet   to the tag in the iFIX Process Database.

 

iFIX - All Wizards

The iFIX - All Wizards button combines the separate wizard dialog boxes   into a single wizard. When you 
click this button, the Tag Name and Description   Wizard appears first. You can move through the dialog 
boxes using the   Next and Back buttons, entering appropriate information and making selections   in each. 
When you reach the final page of the Driver Wizard, click Finish   to add the new tag information to the tar-
get application section of the   spreadsheet. The following lists the wizard pages in the order they appear   
in:

 l Tag   Name and Description Wizard

 l Block   Type and Scan Time Wizard

 l Select   Driver Wizard

 l Summary   – this page is displayed only when the full iFIX Wizard is used.

You can choose not to add a prefix or suffix to the tag name in the   Tag Name and Description Wizard; 
however, the Discover and Auto Configure may make changes to the tag name, based on which char-
acters   are recognized as valid. For more information about naming conventions,   refer to Tag Name and 
Description Wizard.

 

Tag Name and Description Wizard

The Tag Name and Description Wizard is where you can add a prefix and/or   suffix to the names of all the 
currently selected tags you want to add   to the target application section of the spreadsheet, and, ulti-
mately,   your process database application. Adding a prefix or suffix helps to   identify these tags as the 
ones that were extracted from a source file.

Tag Name Check Box

Select this check box to indicate that you want to add a prefix and/or   suffix to all of the currently selected 
tags you are adding to your database.   You can also choose whether to truncate the tag name to the first 
30 characters   or the last 30 characters.

Tag Name Prefix

Specifies the prefix to add to the tag names when adding tags the database.   Prefixes must follow the 
iFIX naming conventions. The maximum number of   characters is 30.
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Tag Name Suffix

Specifies the suffix to add to the tag names when adding tags to the   database. Suffixes must follow the 
iFIX naming conventions. The maximum   number of characters is 30.

Use first 30 Characters

Specifies that if the tag names exceed 30 characters, the names will   be truncated to the first 30 char-
acters when added to the database. These   30 characters include any prefix or suffix added to the tag 
name.

Use Last 30 Characters

Specifies that if the tag names exceed 30 characters, the names will   be truncated to the last 30 char-
acters when added to the database. These   30 characters include any prefix or suffix added to the tag 
name.

Illegal Character Substitution

Specifies the character that will replace all invalid characters in   a symbol name. The default is an under-
score ( _ ).

Illegal First Character Substitution

Specifies the character that will replace the first character, if it   is not a valid iFIX character. The default 
is a capital letter A.

For more information on character substitutions, refer to the Naming   Conventions section.

Description Check Box

Select this check box to indicate that you want to copy the discovered   comment to the Description field 
and/or add a prefix to the Description   field when it is copied.

Copy the discovered Comment...

Select this check box to indicate that if a selected tag has any information   in its Comments field, that the 
first 40 characters will be copied to   the Description field for the corresponding tag in the iFIX section of   
the spreadsheet. The maximum length of the iFIX Description field is 40   characters. These 40 char-
acters include any Description Prefix you specify.

NOTE: OPC servers   do not store comments about OPC items; therefore, the OPC Discovery Agent   cannot 
browse comments from OPC Servers. However, the Fully Qualified   ItemID is stored and can be copied to the 
Description field in the iFIX   section of the spreadsheet. If you select this check box, but no Fully   Qualified 
ItemID was found, the Description field remains blank unless   you enter a prefix. In this case, only the prefix 
displays in the Description   field.

Description Prefix

Specifies the prefix to add to the description when the tags are added   to the database. Prefixes must fol-
low the iFIX naming conventions. The   maximum number of characters is 40.

 

Naming Conventions

In most cases the names of the tags that are extracted from a PLC project   file or OPC Server will not fol-
low the same naming conventions as the   target application you are adding the tags to. Therefore, when 
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tag information   is added to the target application section of the spreadsheet, the tag    names must follow 
the same naming conventions as your target database   application; otherwise, the tag creation in the tar-
get database application   will fail. These rules are valid whether you are adding prefixes and/or   suffixes in 
the Tag Name and Description Wizard, or making the changes   manually in the spreadsheet.

iFIX Naming Conventions

iFIX tag names must begin with a letter or a number and can be a maximum   of 30 characters. Tag 
names can also include the following special characters:

( - ) Dashes ( # ) Number signs
( \ ) Back slashes ( [ ) Open brackets
( _ ) Underscores ( ] ) Close brackets
( / ) Forward slashes ( % ) Percent signs
( ! ) Exclamation points ( $ ) Dollar signs
( | ) Pipes  

Conversion Process

Prefixes and suffixes that you add using the Tag Name and Description   Wizard must follow the naming 
conventions of iFIX. You can choose   not to add a prefix or suffix to the tags; however, be aware that the   
Discover and Auto Configure will automatically convert tag names   that do not follow the naming con-
ventions. The conversion process is as   follows:

 l Whether a valid prefix   and/or suffix is added, the Name is checked before being added to the   tar-
get application section of the spreadsheet. Using the default character   substitution, any invalid 
characters are replaced with an underscore (   _ ). For example, you have added the prefix MyTag. 
Therefore, the tag   name "Counter2" is changed to MyTag_Counter2_. The quotation   marks are 
invalid characters and are changed to underscores.

 l If the first character   is not a valid iFIX character, it is replaced with the first character   substitution 
you defined. For example, you have not added a prefix or   suffix and you are using the default first 
character substitution (the   letter A) and the default character substitution (an underscore). There-
fore,   the tag name "Counter2" is changed to ACounter2_. The quotation   marks are invalid char-
acters; the first invalid character is changed to   an A because it is not a valid iFIX character, and 
the second invalid   character is changed to an underscore.

 l The tag name is checked   for uniqueness. If the tag name already exists within this Discovery 
tool,   the last character(s) of the tag name are replaced with a number to aid   in the uniqueness. 
The number that is appended replaces the last character(s)   in the tag name. The numbering starts 
at 1 and increments by 1 for each   duplicate tag name, up to 99,999. For example:

 l The first tag   name is MyTag_AAAAAAAAAAAAAAAAAAAAAAAA.

 l The next tag   name is a duplicate of the first, so it will change to MyTag_
AAAAAAAAAAAAAAAAAAAAAAA1.

 l The next duplicate   will change to MyTag_AAAAAAAAAAAAAAAAAAAAAAA2.

 l The tenth duplicate   will change to MyTag_AAAAAAAAAAAAAAAAAAAAAA10 and so 
on.

 

Block Type and Scan Time Wizard
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The Block Type and Scan Time Wizard is where you select the type of   block you want to assign to all of 
the currently selected tags you want   to add to the target application section of the spreadsheet, and, ulti-
mately,   your process database application. You can also set a scan time for the   tags or choose excep-
tion-based processing.

Block Type Check Box

Select this check box to indicate that you want to choose a block type   to assign to all of the currently 
selected tags you are adding to your   database. Selecting this check box enables the Block Type list.

Block Type

Specifies the type of block you want to assign to all of the currently   selected tags in the spreadsheet. 
This list is available only when the   Block Type check box is selected.

NOTE:   iFIX must be installed and running to display a list of  valid   block types.

Scan Time Check Box

Select this check box to indicate that you want to set either a scan   time or exception-based processing 
for the currently selected tags you   are adding to your database. This check box is not available if you 
select   an AO, AR,   DO, or DR block type.

Process by Exception Check Box

Select this check box to indicate that you want to use exception-based   processing to scan the tags after 
they have been added to your database.   Exception-based processing means that the blocks are pro-
cessed by exception,   not at scheduled time intervals.

When you select this check box, an E   is displayed in the Scan Time field and you cannot change it or 
access   the Phase At field.

For more information about exception-based processing, see the Understanding Exception-Based Pro-
cessing   topic in the iFIX online help.

Scan Time

Specifies the scan time to use for time-based processing. Time-based   processing means that the 
blocks are processed at a scheduled time interval.   The format for scan times is:

time unit

Valid units are M (minutes) and H (hours). If you do not enter a unit   of time, it is assumed that the unit is 
seconds.

For example, to scan a block every 3 minutes, enter: 

3M

To scan a block every 30 seconds, enter:

30

For more information about time-based processing, see the Understanding   Time-Based Processing 
topic in the iFIX online help.
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Phase At

Specifies the phase time to use for time-based processing. Phasing staggers   the time at which the 
blocks are scanned. The phase time must have the   same unit or one unit lower than the scan time unit. 

For example, if the scan time is 3 minutes and you want to the scan   phased at 1 minute 30 seconds, 
enter:

1:30

To specify a 30-second phase instead, enter:

0:30

For more information about phasing, see the Phasing   topic in the iFIX online help.

 

Driver Wizard

The Select Driver page of the Driver Wizard is where you select the   driver that the database adds the 
tags to. On this page you will find   a list of the available drivers you can add the tags to; that is, the   
drivers that are installed on your computer and are associated with the   Discovery Agent you used. This 
page also displays a brief description   of the selected driver.

 

OPC Driver - Group Selection

The Group Selection page is where you select the OPC Client driver server   and the group that the OPC 
items will be added to. On this page you will   find a system tree-like list of the existing servers and groups 
that have   been configured for the OPC Client driver that match the ProgID of the   OPC server you are 
working with. The list of servers and groups that display   are from the OPC Client driver configuration 
that match either the version   dependent or version independent OPC server ProgID, and the local or 
remote   machine (including remote machine name) selected in the Discovery Agent   Wizard. 

When this dialog box opens, the OPC Discovery Agent checks to see if   the OPC server you are working 
with already exists in the iFIX OPC Client   driver. If it does not exist, the server and a group, with default 
settings,   are automatically added to the OPC Client driver configuration. However,   if the server exists 
but it has no groups configured for it, a group is   added, with default settings. The server and group are 
then displayed   in the selection tree. The new server and group are enabled and the OPC   Client driver 
configuration is saved automatically. 

If the group you want does not exist or requires changes, you can open   the Add/Modify OPC Group dia-
log box to make additions or changes to the   groups. 

Alternatively, you can launch the OPC Client driver Power Tool where   you can add or change servers 
and groups; however, if you add a server   with a ProgID that is different from the OPC server you are 
working with,   it will not display. When you complete your changes in the Power Tool,   return to this page 
and click the Refresh button to update the servers   and groups.

OPC Server Name

Display only. Specifies the OPC server that the items you are adding   to the database originated from. 
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When you use a remote OPC server, the remote machine name or TCP/IP   address is appended to the 
OPC server name. A remote OPC Server name uses   the format <ipaddress>\<OPC server name> or 
<machine name>\<OPC   server name>. For example, 3.6.9.12\Intellution.IntellutionGatewayServer.

A local OPC Server name uses the format <.>\<OPC server name>,   where the period (.) represents the 
local machine. For example, .\Intellution.IntellutionGatewayServer.

OPC Server Description

Display only. Specifies the description of the OPC server.

iFIX OPC Client

Displays the servers and associated groups that are currently configured   for the OPC Client driver.

Add New Group

Use this button to open the Add New OPC Group dialog box where you can   add a new group con-
figuration for the selected OPC Client server.

View Properties

Display only. Specifies the configuration properties of the selected   OPC Client server. This button is 
available only when you have selected   a server.

Modify Group

Use this button to open the Modify OPC Group dialog box where you can   change the configuration of the 
selected group. This button is available   only when you have selected a group.

Run OPC Power Tool

Use this button to open the OPC Client Driver's Power Tool where you   can add or change the desired 
server and/or group. 

Refresh

Use this button to refresh the server and group list after modifying   the driver's Power Tool.

 

Click OK to go to the Summary page if you   are using the iFIX - All Wizards feature. If you are using the 
Driver   Wizard alone, click OK to update the currently selected items in the target   application section of 
the spreadsheet. Click Back to return to the Select Driver page.

 

Add/Modify OPC Group

The Add/Modify OPC Group dialog box is where you can add a new group   to a server displayed in the 
OPC Driver - Group Selection dialog box,   or modify an existing group. Any groups you add using this 
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dialog box   are automatically displayed in the list on the Group Selection dialog   box. A group is auto-
matically enabled after you add it.

The fields available for configuration on this dialog box are the same   whether you use the Add New 
Group button or the Modify Group button on   the Group Selection dialog box; the only difference is that 
the button   you click determines the title of the dialog box.

This dialog box is the same as the properties viewer for groups on the   GE OPC Client Power Tool. This 
provides you with the same configuration   fields, allowing you to bypass the OPC Client Power Tool. 
However, group   information that you add or change in this dialog box is automatically   updated in the 
Power Tool. 

NOTES:

 l Changes to a server can   only be made in the OPC Client Power Tool.

 l Some OPC Servers do not   allow group names to be changed. An error message is displayed if this   is 
the case. 

For detailed information about configuring OPC Client groups, refer   to the OPC Client driver online help.

Working with Servers and Groups for the OPC Client Driver

Selecting a server and a group   | Adding servers or groups to the driver | Viewing server properties

 To select a server   and a group:

 1. Select   the OPC client driver you want to add the database tags to and click   Next. The OPC Cli-
ent - Group Selection page appears.

 2. From the list of   servers, expand the server with the group you want and select the desired   group.

If the server or group information you want   is not available, refer to the procedures To   add an 
OPC group and To add or change a server   or group using the Power Tool.

 3. Click OK. The server,   group, and item information is added to the I/O Address field in the target   
application section of the spreadsheet for the selected items.

NOTE:   The Driver Wizard does not automatically generate an I/O address for a   tag with a blank Fully 
Qualified Item ID field in the Discovery Agent   section of the spreadsheet. If you selected one of these 
tags to add to   iFIX, the I/O Address field remains blank, or contains the ServerX.GroupY   name only 
when the Driver Wizard completes. You can double-click the I/O   Address field and manually enter an 
I/O address before or after adding   the tag to iFIX or you can enter an I/O address directly in Database 
Manager   after the tag has been added to iFIX.

 To add a   server or group to the OPC Client driver:

 1. If the server or   group you want is not available, click the Run OPC Power Tool button.   The I/O 
Driver Server Connection dialog box appears, allowing you to connect   to the OPC Client Driver 
Power Tool.

IMPORTANT:   Make sure you connect to the locally installed OPC Client driver. If you   connect to a 
remote driver, the changes you make to its configuration   file will not display in the OPC Client- Group 
Selection page.

 2. In the Power Tool,   add the required server and/or group information and save your changes.   For 
more information about adding servers and groups, refer to the OPC   Client Driver online help.
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 3. On the OPC Driver   - Group Selection page of the Driver Wizard, click the Refresh button   to 
refresh the list of servers and groups. Your changes now appear in   the list.

 To view   server properties

 l On the OPC Driver   - Group Selection page, select the server you want to view and click View   
Properties. The iFIX OPC Client Server Properties dialog box appears.

NOTE:   If you need to make changes to the server properties, see To   add or change a server or group 
using the Power Tool.

 

Adding or Modifying an OPC Group

Adding a new OPC group | Modifying   an OPC group

 To add a   new OPC group:

 1. From the list of   servers and groups on the OPC Driver - Group Selection dialog box, select   the 
server that you want to add a group to.

 2. Click the Add New   Group button. The Add New OPC Group dialog box appears.

 3. Configure the group,   as required. For more information, refer to the OPC Client Driver online   help.

 4. Click OK to save   your changes and return to the OPC Driver - Group Selection dialog box.   The 
new group appears below the selected server.

 To modify   an OPC group:

 1. From the list of   servers and groups on the OPC Driver - Group Selection dialog box, select   the 
group you want to change.

 2. Click the Modify   Group button. The Modify OPC Group dialog box appears.

 3. Configure the group,   as required. For more information, refer to the OPC Client Driver online   help.

 4. Click OK to save   your changes and return to the OPC Driver - Device Selection dialog box.   

 

S7A Driver - Device Selection 

The S7A Driver - Device Selection page of the Select Driver Wizard is   where you select the channel and 
device of the S7A driver that the tags   will be added to. On this page you will find a system tree-like list of   
the existing channels and devices that have been configured for the S7A   driver. If the channel and/or 
device you want does not exist, you can   launch the S7A Driver Power Tool to add the necessary inform-
ation.

I/O Driver Name

Display only. Specifies the name of the driver selected on the Select   Driver page, that is, S7A.

Step 7 Program Name

Display only. Specifies the program name that the tags you are adding   to the database originated from.
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Run S7A Power Tool

Use this button to open the S7A Driver Power Tool to add or change the   desired channel and/or device. 

Refresh

Use this button to refresh the channel and device list after modifying   the S7A driver's configuration file 
with the Power Tool.

 

Click OK to go to the Summary page if you   are using the iFIX - All Wizards feature. If you are using the 
Driver   Wizard alone, click OK to update the currently selected items in the target   application section of 
the spreadsheet. Click Back to return to the Select Driver page.

SI7 Driver - Device Selection

The SI7 Driver - Device Selection page of the Select Driver Wizard is   where you select the channel and 
device of the SI7 driver that the tags   will be added to. On this page you will find a system tree-like list of   
the existing channels and devices that have been configured for the SI7   driver. If the channel and/or 
device you want does not exist, you can   launch the SI7 Driver Power Tool to add the necessary inform-
ation.

I/O Driver Name

Display only. Specifies the name of the driver selected on the Select   Driver page, that is, SI7.

Step 7 Program Name

Display only. Specifies the program name that the tags you are adding   to the database originated from.

Run SI7 Power Tool

Use this button to open the SI7 Driver Power Tool to add or change the   desired channel and/or device. 

Refresh

Use this button to refresh the channel and device list after modifying   the SI7 driver's configuration file 
with the Power Tool.

 

Click OK to go to the Summary page if you   are using the iFIX - All Wizards feature. If you are using the 
Driver   Wizard alone, click OK to update the currently selected items in the target   application section of 
the spreadsheet. Click Back to return to the Select Driver page.

Working with Channels and Devices for an S7A Driver

Selecting a channel and a device   | Adding channels and devices to the driver

 To select a channel   and a device for the S7A driver:

 1. Select   the S7A driver and click Next. The S7A Driver - Device Selection page   appears.
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 2. Expand the channel   with the device you want and select the desired device.

If the channel or device information you   want is not available, refer to the procedure To add chan-
nel   and device information to the driver.

 3. Click OK. The driver   and device information is added to the target application section of the   
spreadsheet for the selected tags.

NOTE:   The Driver Wizard does not automatically generate an I/O address for a   tag with a data type 
such as VAT or None. If you selected one of these   tags to add to iFIX, the I/O Address field remains 
blank when the Driver   Wizard completes. You can double-click the I/O Address field and manually   
enter an I/O address before or after adding the tag to iFIX or you can   enter an I/O address directly in 
Database Manager after the tag has been   added to iFIX.

 To add a channel   and device to the S7A driver:

 1. If the channel and/or   device you want is not available, click the Run S7A Power Tool button.   The 
S7A Driver Power Tool Server Connection dialog box appears, allowing   you to connect to the 
driver.

IMPORTANT:   Make sure you connect to the locally installed S7A driver. If you connect   to a remote 
driver, the changes you make to its configuration file will   not display in the S7A Driver - Device Selec-
tion page.

 2. In the S7A Driver   Power Tool, add the applicable channels and/or devices you require and   save 
your changes. For more information about adding channels and devices,   refer to the S7A Driver 
online help.

 3. On the S7A Driver   - Device Selection page, click the Refresh button to refresh the list   of chan-
nels and devices. Your changes now appear in the list.

 

Working with Channels and Devices for an SI7 Driver

Selecting a channel and a device   | Adding channels and devices to the driver

 To select a channel   and a device for the SI7 driver:

 1. Select   the SI7 driver and click Next. The SI7 Driver - Device Selection page   appears.

 2. Expand the channel   with the device you want and select the desired device.

If the channel or device information you   want is not available, refer to the procedure To add chan-
nel   and device information to the driver.

 3. Click OK. The driver   and device information is added to the target application section of the   
spreadsheet for the selected tags.

NOTE:   The Driver Wizard does not automatically generate an I/O address for a   tag with a data type 
such as VAT or None. If you selected one of these   tags to add to iFIX, the I/O Address field remains 
blank when the Driver   Wizard completes. You can double-click the I/O Address field and manually   
enter an I/O address before or after adding the tag to iFIX or you can   enter an I/O address directly in 
Database Manager after the tag has been   added to iFIX.

 To add a channel   and device to the SI7 driver:

 1. If the channel and/or   device you want is not available, click the Run SI7 Power Tool button.   The 
SI7 Driver Power Tool Server Connection dialog box appears, allowing   you to connect to the 
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driver.

IMPORTANT:   Make sure you connect to the locally installed SI7 driver. If you connect   to a remote 
driver, the changes you make to its configuration file will   not display in the SI7 Driver - Device Selec-
tion page.

 2. In the SI7 Driver   Power Tool, add the applicable channels and/or devices you require and   save 
your changes. For more information about adding channels and devices,   refer to the SI7 Driver 
online help.

 3. On the SI7 Driver   - Device Selection page, click the Refresh button to refresh the list   of channels 
and devices. Your changes now appear in the list.

 

ABR Driver - Device Selection 

The ABR Driver - Device Selection page of the Select Driver Wizard is   where you select the channel 
and device of the ABR driver that the tags   will be added to. On this page you will find a system tree-like 
list of   the existing channels and devices that have been configured for the ABR   driver. If the channel 
and/or device you want does not exist, you can   launch the ABR Driver Power Tool to add the necessary 
information.

I/O Driver Name

Display only. Specifies the name of the driver selected on the Select   Driver page; that is, ABR.

ABR Export File Name

Display only. Specifies the file name of the .EAS export file.

Run ABR Power Tool

Use this button to open the ABR Driver Power Tool to add or change the   desired channel and/or device. 

Refresh

Use this button to refresh the channel and device list after modifying   the ABR driver's configuration file 
with the Power Tool.

Click OK to go to the Summary page if you   are using the iFIX - All Wizards feature. If you are using the 
Driver   Wizard alone, click OK to update the currently selected items in the target   application section of 
the spreadsheet. Click Back to return to the Select Driver page.

Working with Channels and Devices for an ABR Driver

Selecting a channel and a device   | Adding channels and devices to the driver

 To select a channel   and a device for the ABR driver:

 1. Select   the ABR driver and click Next. The ABR Driver - Device Selection page   appears.

 2. Expand the channel   with the device you want and select the desired device.
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If the channel or device information you   want is not available, refer to the procedure To add chan-
nel   and device information to the driver.

 3. Click OK. The driver   and device information is added to the target application section of the   
spreadsheet for the selected tags.

NOTE:    The Driver   Wizard does not automatically generate an I/O address for a tag with Memory   
Types that have indirect addresses such as N7:[N100:3]. If you select   one of these tags to add to iFIX, 
the I/O Address contains an ***Error***   when the Driver Wizard completes. In the Spreadsheet, you 
can double-click   the I/O Address field and manually enter an I/O address before adding   the tag to iFIX. 
Or, after adding the tag to iFIX, you can enter an I/O   address directly into Database Manager.

 To add a channel   and device to the ABR driver:

 1. If the channel and/or   device you want is not available, click the Run ABR Power Tool button.   The 
ABR Driver Power Tool Server Connection dialog box appears, allowing   you to connect to the 
driver.

IMPORTANT:   Make sure you connect to the locally installed ABR driver. If you connect   to a remote 
driver, the changes you make to its configuration file will   not display in the ABR Driver - Device Selec-
tion page.

 2. In the ABR Driver   Power Tool, add the applicable channels and/or devices you require and   save 
your changes. For more information about adding channels and devices,   refer to the ABR Driver 
online help.

 3. On the ABR Driver   - Device Selection page, click the Refresh button to refresh the list   of chan-
nels and devices. Your changes now appear in the list.

 

IGS Driver - Device Selection

The IGS Driver - Device Selection page of the Select Driver Wizard is   where you can view the channel 
and device configuration of the IGS driver.   On this page you will find a system tree-like list of the existing 
channels   and devices that have been configured for the IGS driver. If you want   to modify the com-
munication properties of any channel or device, you can   launch the IGS Driver Power Tool to add the 
necessary information.

IGS Server Name

Display only. Specifies the program ID name of the IGS driver.

IGS Server Description

Display only. Specifies the full name of the IGS Server.

iFIX IGS Client 

Display only. Displays the current IGS driver configuration in tree   view. You will see all configured chan-
nels and devices. To modify any   properties for existing channels or devices, use the Run IGS Power 
Tool   button.

NOTE: You cannot   move selected tags to a different device, because the tags were already   configured in the 
IGS driver when you imported the .L5K file.
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Run IGS Power Tool

Use this button to open the IGS Driver Power Tool to add or change the   desired channel and/or device. 

Refresh

Use this button to refresh the channel and device list after modifying   the IGS driver's configuration file 
with the Power Tool.

Click OK to go to the Summary page if you   are using the iFIX - All Wizards feature. If you are using the 
Driver   Wizard alone, click OK to update the currently selected items in the target   application section of 
the spreadsheet. Click Back to return to the Select Driver page.

Working with Channels and Devices for an IGS Driver

 To add a channel   and device to the IGS driver:

 1. If the channel and/or   device you want is not available, click the Run IGS Power Tool button.   The 
IGS Driver Power Tool Server Connection dialog box appears, allowing   you to connect to the 
driver.

IMPORTANT:   Make sure you connect to the locally installed IGS driver. If you connect   to a remote 
driver, the changes you make to its configuration file do   not display in the IGS Driver - Device Selec-
tion page.

 2. In the IGS Driver   Power Tool, add or modify communication properties of the applicable channels   
and/or devices you require and save your changes. For more information   about adding channels 
and devices, refer to the IGS Driver online help.

 3. On the IGS Driver   - Device Selection page, click the Refresh button to refresh the list   of channels 
and devices. Your changes now appear in the list.

 

Summary

The Summary page displays a summary of the selections you made on all   of the wizards. This page is 
displayed only when the iFIX - All Wizards   is run. If you want to make any changes, you can choose to 
click   the Back button to return to a wizard, or click Finish and manually edit   the spreadsheet. For more 
information, refer to Modifying   Tag Information in iFIX.

 

Modifying iFIX Columns in the Spreadsheet

Adding an iFIX field as a column to the   current project | Removing a column from the current   project | Renam-
ing a column in the current project   | Changing the default iFIX column settings for new   projects

 To add an iFIX field   as a column to the current project:

NOTE:   The column settings that you modify using these steps do not change other   existing projects 
(.DAC files) or new projects. The modified settings   apply only to the current project.
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 1. On the View menu,   click Target Column Settings, and then select Current Project. The Column   
Settings - Current Project dialog box appears.

 2. Select the Available   column that you want to display. 

 3. Optionally, if you   want to give this column another name, enter a name in the Column Name   edit 
box.

 4. Click the Add button.   This moves the column name from the Available Columns list box to the   
Display Columns list box. If you entered another name in the Column Name   edit box, that new 
name appears in the Display Columns list box, instead   of the actual name.

NOTE:   The order in which the columns appear in the Display Columns list box   determines the order 
of the columns in the spreadsheet. 

 3. Optionally, use the   up and down arrows to move in the Display Columns list box to change the   
column order.

 4. Click OK.

 To remove a column   from the current project:

NOTE:   The column settings that you modify using these steps do not change other   existing projects 
(.DAC files) or new projects. The modified settings   apply only to the current project.

 1. On the View menu,   click Target Column Settings, and then select Current Project. The Column   
Settings - Current Project dialog box appears.

 2. In the Display Columns   list box, select the column that you want to remove, and click the 
Remove   button. This moves the column name from the Display Columns list box to   the Available 
Columns list box. 

IMPORTANT:   The following columns can not be removed: Tag Name, Type, Driver, I/O   Address, H/W, 
and Signal Cond.

NOTE:   The order in which the columns appear in the Display Columns list box   determines the order 
of the columns in the spreadsheet. 

 3. Click OK.

 To rename a column   in the current project:

NOTE:   The column settings that you modify using these steps do not change other   existing projects 
(.DAC files) or new projects. The modified settings   apply only to the current project.

 1. On the View menu,   click Target Column Settings, and then select Current Project. The Column   
Settings - Current Project dialog box appears.

 2. In the Display Columns   list box, select the column that you want to rename. 

 3. Enter the new name   in the Column Name edit box and then click in another field.

 4. Click OK.

 To change the   default iFIX column settings for new projects:

 1. On the View menu,   click Target Column Settings, and then select Default Settings for 
HMI/SCADA   iFIX. The Column Settings - Default Project dialog box appears.

 2. To remove a column,   in the Display Columns list box, select the column that you want to remove,   
and click the Remove button. This moves the column name from the Display   Columns list box to 
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the Available Columns list box. 

 3. To add a column,   in the Available Columns list box:

 n Select the column   that you want to display.

 n Optionally, if   you want to give this column another name, enter a name in the Column   
Name edit box.

 n Click the Add   button. This moves the column name from the Available Columns list box   to 
the Display Columns list box. If you entered another name in the Column   Name edit box, 
that new name appears in the Display Columns list box,   instead of the actual name.

NOTE:   The order in which the columns appear in the Display Columns list box   determines the 
order of the columns in the spreadsheet. 

 4. Optionally, use the   up and down arrows to move in the Display Columns list box to change the   
column order.

 5. Click OK.

IMPORTANT: Changes   made to the Default Settings for iFIX take affect   for new projects and only after a 
restart of the Discovery and Auto Configure   utility. 

 

Using the iFIXColumns.txt File to Modify iFIX Columns   in the Spreadsheet

An alternative way to modify iFIX columns in the spreadsheet is by using   the iFIXColumns.txt file. This 
method is provided only for backwards compatibility.

NOTES:

 n The recommended   way to add or remove columns is through the user interface, using the   Target 
Column Settings command in the View menu. For steps, refer to the   Modifying the iFIX Columns in the 
Spreadsheet   section. 

 n If you   manually edit the iFixColumns.txt file and subsequently use the Target   Column Settings com-
mand in the View menu, the default settings in the   iFixColumns.txt file are overwritten. Any comment 
lines (lines that begin   with a semicolon) are removed when the iFixColumns.txt file is overwritten.   

 n For more information   on the iFIX database fields, refer to the iFIX Database Reference e-book,   in the 
"Database Block Field Reference" section, and look for   the fields in the section for the individual block.

Adding an iFIX field as a column using   the iFIXColumns.txt file | Viewing the available iFIX   columns | Remov-
ing a column from the spreadsheet   using the iFIXColumns.txt file

 To add an iFIX field   as a column using the iFIXColumns.txt file:

 1. Open the iFIXColumns.txt   file that is installed in the same location as the Discover and Auto Con-
figure   application. By default, this location is C:\Program Files\Proficy\Discovery.   The default 
columns are listed, as well as information to help you use   the file.

 2. Add the DisplayName   and Field for the column you want to add to the spreadsheet. For example,   
to add the column Low EGU, enter the following in the iFIXColumns.txt   file:

Low EGU, A_ELO

NOTE:   The order in which the columns appear in this file determines the order   of the columns in the 
spreadsheet. 

 3. Save the iFIXColumns.txt   file and open the Discover and Auto Configure application. The new 
column   displays on the target application side of the spreadsheet.
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NOTES:

 l If there is an error   in a row you added to the iFIXColumns.txt file, (for example, you entered   the 
Field information incorrectly) the row is ignored and the column is   not added to the spread-
sheet.

 l If the information   you added to the iFIXColumns.txt file exceeds 100 characters in a line,   the 
information beyond the first 100 characters is ignored and is not   added to the spreadsheet.

 l If the Discover and   Auto Configure application is open when you make a change to the 
iFIXColumns.txt   file, you must exit and restart the application for the changes to take   effect.

 l If you delete the   iFixColumns.txt file, the application will regenerate the file with the   default 
columns.

 To view the available   iFIX columns outside of the DAC tool:

 1. Open the iFIX Database   Manager.

 2. From the View menu,   choose Properties. The Properties dialog box appears.

 3. From the Available   Columns list, select a column name. The Field Name field displays the   name 
of the iFIX field. 

 4. Make note of this   information. It is required to add the column information to the iFIXColumns.txt   
file.

 To remove a column   from the spreadsheet using the iFIXColumns.txt file:

 1. Open the iFIXColumns.txt   file that is installed in the same location as the Discover and Auto Con-
figure   application. By default, this location is C:\Program Files\Proficy\Discovery.   The default 
columns and any other columns you may have added are listed,   as well as information to help 
you use the file.

 2. To permanently remove   a column from the spreadsheet, delete the column information.

 3. To hide a column,   insert a semi colon (;) at the beginning of the row for the column you   want to 
hide.

 4. Save your changes   and open the Discover and Auto Configure application. The column you 
removed   or hid is no longer displayed on the target application side of the spreadsheet.

 

Using the iFIXColumns.txt File to Modify iFIX Columns   in the Spreadsheet

An alternative way to modify iFIX columns in the spreadsheet is by using   the iFIXColumns.txt file. This 
method is provided only for backwards compatibility.

NOTES:

 n The recommended   way to add or remove columns is through the user interface, using the   Target 
Column Settings command in the View menu. For steps, refer to the   Modifying the iFIX Columns in the 
Spreadsheet   section. 

 n If you   manually edit the iFixColumns.txt file and subsequently use the Target   Column Settings com-
mand in the View menu, the default settings in the   iFixColumns.txt file are overwritten. Any comment 
lines (lines that begin   with a semicolon) are removed when the iFixColumns.txt file is overwritten.   

 n For more information   on the iFIX database fields, refer to the iFIX Database Reference e-book,   in the 
"Database Block Field Reference" section, and look for   the fields in the section for the individual block.
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Adding an iFIX field as a column using   the iFIXColumns.txt file | Viewing the available iFIX   columns | Remov-
ing a column from the spreadsheet   using the iFIXColumns.txt file

 To add an iFIX field   as a column using the iFIXColumns.txt file:

 1. Open the iFIXColumns.txt   file that is installed in the same location as the Discover and Auto Con-
figure   application. By default, this location is C:\Program Files\Proficy\Discovery.   The default 
columns are listed, as well as information to help you use   the file.

 2. Add the DisplayName   and Field for the column you want to add to the spreadsheet. For example,   
to add the column Low EGU, enter the following in the iFIXColumns.txt   file:

Low EGU, A_ELO

NOTE:   The order in which the columns appear in this file determines the order   of the columns in the 
spreadsheet. 

 3. Save the iFIXColumns.txt   file and open the Discover and Auto Configure application. The new 
column   displays on the target application side of the spreadsheet.

NOTES:

 l If there is an error   in a row you added to the iFIXColumns.txt file, (for example, you entered   the 
Field information incorrectly) the row is ignored and the column is   not added to the spread-
sheet.

 l If the information   you added to the iFIXColumns.txt file exceeds 100 characters in a line,   the 
information beyond the first 100 characters is ignored and is not   added to the spreadsheet.

 l If the Discover and   Auto Configure application is open when you make a change to the 
iFIXColumns.txt   file, you must exit and restart the application for the changes to take   effect.

 l If you delete the   iFixColumns.txt file, the application will regenerate the file with the   default 
columns.

 To view the available   iFIX columns outside of the DAC tool:

 1. Open the iFIX Database   Manager.

 2. From the View menu,   choose Properties. The Properties dialog box appears.

 3. From the Available   Columns list, select a column name. The Field Name field displays the   name 
of the iFIX field. 

 4. Make note of this   information. It is required to add the column information to the iFIXColumns.txt   
file.

 To remove a column   from the spreadsheet using the iFIXColumns.txt file:

 1. Open the iFIXColumns.txt   file that is installed in the same location as the Discover and Auto Con-
figure   application. By default, this location is C:\Program Files\Proficy\Discovery.   The default 
columns and any other columns you may have added are listed,   as well as information to help 
you use the file.

 2. To permanently remove   a column from the spreadsheet, delete the column information.

 3. To hide a column,   insert a semi colon (;) at the beginning of the row for the column you   want to 
hide.

 4. Save your changes   and open the Discover and Auto Configure application. The column you 
removed   or hid is no longer displayed on the target application side of the spreadsheet.

 

© 2020 General Electric Company. All rights reserved. 81



Adding GE Historian Fields as Columns

If you are using GE Historian with iFIX 5.0 and above, you can   now add GE Historian columns 
(HistTagDesc, Collect, and CollectionInterval)   to your spreadsheet. To do this, use the Quick Select but-
ton in the Column   Settings dialog box. 

The following table describes the GE Historian fields.

The field... Displays... Valid Entry
A_HIST_DESC The GE Historian description. String; maximum of 128 characters.
A_HIST_
COLLECT

Sets whether or not this block is 
under collection.   

Yes or No.

A_HIST_
INTERVAL

The collection interval for this block. 
The value   of this field must be 
greater than the value of the A_
HIST_OFFSET and   F_HIST_
OFFSET fields.

Use the following formula to determ-
ine if the entered   value is acceptable 
for this field.

A_HIST_INTERVAL > A_HIST_
OFFSET * 1000 

NOTE: The   values for the A_HIST_
OFFSET field is in seconds. 

A float value, in milliseconds. Values 
must be entered   in increments of 
100. Minimum value: 100 ms.

NOTE: For more   information on the Historian fields or other database fields, refer to   the iFIX Database Refer-
ence e-book, in the "Database Block Field   Reference" section, and look for the field in the section for the   indi-
vidual block.

 To add   Historian fields as columns in your spreadsheet:

 1. On the View menu,   select Target Column Settings, and point to Current Project or Default   Set-
tings for iFIX. The Current Project applies to   the currently open project only. The Default Settings 
apply to any new    projects you open the next time you restart the DAC tool; changing the   Default 
Settings does not change your currently open project.

The Column Settings dialog box appears.

 2. Click the Quick Select   button and click the Select All Historian Fields option. The Historian   
related fields (HistTagDesc, Collect, and CollectionInterval) appear in   the Available Columns list 
on the left of this dialog box.

 3. To add these columns   to your spreadsheet, while they are still selected, click the Add button.   The 
Historian fields now appear in the Display Columns field on the right   side of this dialog box.

 4. Click OK to apply your changes.

Running iFIX - All Wizards
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 To run iFIX - All Wizards:

 1. In the spreadsheet,   select the tags you want to add to your database.

 2. On the iFIX Wizards toolbar,   click the  iFIX - All Wizards button. The Tag Name Generation   
Wizard appears.

 3. Use each of the wizard   dialog boxes, adding and selecting the applicable information to define   
your tags. 

 4. Click the Next and   Back, and OK buttons to move through each of the dialog boxes.

 5. On the Summary page,   click Finish. The tags are added to the target application section of   the 
spreadsheet.

 

Generating Tag Names

 To generate tag names:

 1. In the spreadsheet,   select the tags you want to add to your database.

 2. On the iFIX Wizards   toolbar, click the  Tag Name Generation Wizard button. The   Tag Name 
Generation Wizard appears.

 3. If applicable, in   the Tag Name Prefix field, enter a prefix for the names of the tags you   are adding 
to your database.

 4. If applicable, in   the Tag Name Suffix field, enter a suffix for the names of the tags you   are adding 
to your database.

 5. Select the Use first   30 characters option or the Use last 30 characters option to limit the   tag name 
to either the first 30 characters or the last 30 characters,   respectively.

 6. If applicable, enter   a character that will replace all invalid characters in a tag name when   a valid 
iFIX prefix and/or suffix is added. The default is an underscore   ( _ ).

 7. If applicable, enter   a character that will replace the first character in a tag name if it   is not a valid 
iFIX character. The default is the capital letter A.

 8. If applicable, select   the Copy the discovered Comment to the iFIX tag description check box   to 
copy the information stored in the tag's Comment field to the Description   field in the target applic-
ation section of the spreadsheet.

NOTE:   OPC servers do not store comments about OPC items; therefore, the OPC   Discovery Agent 
cannot browse comments from OPC Servers. However, the   Fully Qualified ItemID is stored and can be 
copied to the Description   field in the iFIX section of the spreadsheet. If you select this check   box, but 
no Fully Qualified ItemID was found, the Description field remains   blank unless you enter a prefix. In 
this case, only the prefix displays   in the Description field.

 9. Click OK. The tags   are added to the target application section of the spreadsheet.

 

Assigning Block Types and Scan Times

Assigning block types | Assigning   scan times
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 To assign block   types:

 1. In the spreadsheet,   select the tags you want to add to your database.

 2. If applicable, generate tag names.

 3. On the iFIX Wizards   toolbar, click the  Block Types and Scan Times Wizard button.   The 
Block Types and Scan Times Wizard appears.

 4. Select the Block   Type check box.

 5. From the Block Type   list, select the type of block you want to assign to all the tags you   are 
adding to your database.

NOTE:   iFIX must be installed and running to display a list of  valid   block types.

 6. Click OK. In the   HMI/SCADA section of the spreadsheet, the Type field for each of the selected   
tags displays the selected block type.

NOTE:   All of the selected tags are assigned the same block type. You can change   the block type for 
individual tags by double-clicking in the Type field   and entering a new block type.

 To assign   scan times:

 1. In the spreadsheet,   select the tags you want to add to your database.

 2. If applicable, generate tag names.

 3. On the iFIX Wizards   toolbar, click the  Block Types and Scan Times Wizard button.   The 
Block Types and Scan Times Wizard appears.

 4. Select the Scan Time   check box. This check box is not available if you select an AO, AR, DO,   or 
DR block type.

 5. If applicable, select   the Process by Exception check box to assign exception-based processing   
to the selected tags. The Scan Time field displays an E.   If this check box is selected, the Scan 
Time and Phase At fields are not   available. 

Selecting this check box means that your   HMI/SCADA application will scan the tags using 
exception-based processing.

 6. If applicable, in   the Scan Time field, enter a scan time to assign to the selected tags.   The 
HMI/SCADA application will scan the tags using time-based processing.   

 7. If applicable, in   the Phase At field, enter a phase time to use in addition to the scan   time.

NOTE:   If you enter a phase time, all of the selected tags will be phased at   the same time. You can 
change the phase time for individual tags by double-clicking   in the Scan Time field and entering a 
new phase time.

 

Selecting a Driver

 To select a driver:

 1. In the spreadsheet,   select the tags you want to add to your database.

 2. On the iFIX Wizards   toolbar, click the  Driver Wizard button. The Select Driver   page of the 

84 © 2020 General Electric Company. All rights reserved.



Select Driver Wizard appears.

 3. From the list of   available drivers, select the driver you want.

NOTES:

 l The available driver(s)   depends on the Discovery Agent you are using.

 l If the appropriate   driver is not installed on the target application, an error message is   dis-
played. For information about this error message, refer to Troubleshooting   the Driver Wizard.

 

Adding Tags to iFIX

IMPORTANT:   iFIX must be installed and running on your computer before you can run   the Discover and Auto 
Configure. 

 To add tags to iFIX:

 1. Start iFIX if it   is not already running.

 2. Run the Discovery   Agent Selection Wizard and extract tag information from the applicable   
source. The tag information is displayed in the Discovery Agent section   of the spreadsheet.

 3. Select   the tags you want to add to the database.

 4. Run the iFIX - All   Wizards, or use each of the wizards separately to generate   tag names, assign   
block types and scan times, and select   a driver and device (or OPC   server and group). The tag 
information is displayed in the HMI/SCADA   section of the spreadsheet.

NOTE:   The Driver Wizard does not automatically generate an I/O address for a   tag with a data type 
such as VAT or None or a blank Fully Qualified ItemID.   If you selected one of these tags to add to iFIX, 
the I/O Address field   remains blank when the Driver Wizard completes. You can double-click the   I/O 
Address field and manually enter an I/O address before or after adding   the tag to iFIX or you can enter 
an I/O address directly in Database Manager   after the tag has been added to iFIX.

 5. Click the Add to   iFIX button. The tag information is added to the Database Manager. If   the tags 
are successfully added to the database, the Status column in   the target application section dis-
plays OK   with a green background. You may need to use the horizontal scroll to   view this 
column. If the tags were not successfully added to the database,   the Status column displays Tag 
Creation   Failed with a red background.

NOTES:

 l A small red square   in a cell indicates bad data; for example, the scan time is out of range   or the 
I/O address is invalid. Hover the mouse pointer over the red square   to display a pop up explan-
ation for the bad data. If necessary, you can   change the data to valid values. For more inform-
ation, see Modifying   Tag Information in iFIX.

 l iFIX does not allow   duplicate tag names to exist in the database. If you attempt to add a   tag 
with a tag name that already exists in the database, a red square   appears in the cell with the 
message: "Name already exists in database   as an alarm area or tag."

 6. After you successfully   add your tags to the iFIX database, you can view them and work with 
them   in the Database Manager. For more information, refer to the section Working with the Pro-
cess Database in   the iFIX online help.

NOTE:   When you add tags to the iFIX Database Manager with the Discover and Auto Configure, SAC 
(Scan, Alarm, and Control program in iFIX)   is not automatically stopped and restarted; therefore, the 

© 2020 General Electric Company. All rights reserved. 85



added tags   remain OFF SCAN. You must save and reload the process database or you   can manually 
set the tags to ON SCAN as well as make any other necessary   changes to the individual tags.

 

Modifying Tag Information for iFIX

When you are working with a block of tags and add the tag information   to the target section of the spread-
sheet, the tags display all the same   information (for example, scan and phase times). You can change 
the information   for individual tags either before or after you add the tags to your database.

 To modify tag information:

 1. In the target application   section of the spreadsheet, double-click the specific cell you want to   
change. The cursor is positioned in the cell, and you can add, remove,   or modify the tag inform-
ation for the individual tag.

 2. Click the Modify   in iFIX button. The changes you made are applied to the tag information   in the 
database.

 

Drivers

This section provides you with information about the drivers that the   selected database tags can be 
added to. Each driver is associated with   a Discovery Agent and a target application that has its own 
database in   which to store its tags and their information. 

NOTE: The driver   must be added to the iFIX SCU   (System Configuration Utility), in the Configured I/O Drivers 
list before   it can be configured to run in iFIX and be used with the Discover and Auto Configure. If iFIX is 
already running, you must shutdown   and restart iFIX for the changes to take effect.

The following are the drivers currently supported by each Discovery   Agent, and the associated target 
application:

OPC Discovery Agent

Driver Name Target Application
OPC Client 7.3x iFIX

Siemens S7 Discovery Agent

Driver Name Target Application
GE SI7 version 7.2x iFIX
InCoSol S7A version 7.2x iFIX

Allen-Bradley PLC-5/SLC 500/MicroLogix Families Discovery Agent

Driver Name Target Application
GE ABR version 7.2x iFIX
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IGS - Industrial Gateway Server Discovery Agent 

Driver Name Target Application
GE IGS version 7.41 and 7.51 or greater iFIX

GE OPC Client Driver

The OPC Client driver is a GE version 7.x I/O driver. It provides   the interface and communications pro-
tocol between OPC servers and your   process control software.

For detailed information, refer to the OPC Client online help.

GE SI7 Driver

The SI7 driver is a GE version 7.x I/O driver. It provides the   interface and communications protocol 
between Siemens Simatic hardware   and your process control software.

The SI7 driver supports datablock numbers up to 8191. If you add more   than 8191 datablocks to the tar-
get database for the SI7 driver, the database   will fail the I/O addresses that exceed this number.

For detailed information, refer to the SI7 online help.

 

GE ABR Driver

The ABR driver is a GE version 7.2x I/O driver. It provides the   interface and communications protocol 
between Allen-Bradley hardware and   your process control software.

For detailed information, including information on supported data types   and memory/file type inform-
ation, refer to the Supported   File Types topic and the ABR documentation.

 

GE IGS Driver

The IGS driver is a GE version 7.41 and 7.51 or greater, I/O driver.   It provides the interface and com-
munications protocol between the Allen-Bradley   ControlLogix hardware and your process control soft-
ware.

For detailed information on the driver, refer to the IGS online help.

 

InCoSol S7A Driver
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The S7A driver is a GE version 7.x I/O driver developed by Industrial   Communications Solution. It 
provides the interface and communications   protocol between Siemens S7 - 300/400 PLC systems and 
your process control   software.

The S7A driver supports datablock numbers up to 4095. If you add more   than 4095 datablocks to the tar-
get database for the S7A driver, the database   will fail the I/O addresses that exceed this number.

For detailed information, refer to the S7A online help.

 

Troubleshooting

This section provides information for troubleshooting problems that   you may encounter when you are 
using the Discover and Auto Configure.

 l Troubleshooting   the Discovery Agent Selection Wizard

 l Troubleshooting   the Driver Wizard

 l Troubleshooting   Digital Certificate Errors

 

Troubleshooting the Discovery Agent Selection Wizard

Discovery Agent and Target Application Issues

If the appropriate Discovery Agent and/or target application are not   installed or properly registered, warn-
ing messages display, instructing   you to install either the appropriate Discovery Agent or target applic-
ation,   or both. 

Possible reasons for the Discovery Agent or target application not being   installed or not registered are:

 l The Discovery Agent's   or target application's .dll files were manually unregistered.

 l The Discovery Agent(s)   files (.dll's) were deleted.

 l Another application   that the Discover and Auto Configure is dependent on, such as   iFIX, AGLINK 
(for Siemens), or OPC Proxies, was deleted or uninstalled   or unregistered.

Possible reasons for loading errors for the Discovery Agent or target   application are:

 l The target application   or Discovery Agent was registered properly, but is no longer found on   the 
system (deleted or uninstalled), or was moved.

 l The Target or Discover   Agent .dll file is there, but another component is missing, such as iFIX,   
the AGLink .dll.

 l You may not have   the correct version of the Discovery Agent or Target .dll. For example,   you 
install version 2.0 of the Discover and Auto Configure over   version 1.0 (that is, without unin-
stalling version 1.0). If a file is   locked or the tool is running, not all files are overwritten. In this   
case, some files will be from version 1.0 and some from version 2.0. In   this case, a "Loading" 
error displays.
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Problem #1: No target applications are found

If no target applications are registered, the following message displays   when you click Next on the Dis-
covery Agent Selection Wizard Welcome page:

"There were no Target Applications   found. Please install the Target Application that you want to use and   
restart this tool."

Solution

The Discover and Auto Configure application shuts down and   you must install or reinstall the target 
application, or reregister the   target .dll.

Problem #2: No Discovery Agents are found

If no Discovery Agents are registered, the following message displays   when you click Next on the Dis-
covery Agent Selection Wizard Welcome page:

"There were no Discovery Agents found.   Please install the Discovery Agent that you want to use and 
restart this   tool."

Solution

The Discover and Auto Configure application shuts down and   you must install or reinstall the applic-
ation, or register the Discovery   Agent .dll.

Problem #3: No target applications or Discovery Agents are found

If neither a target application nor Discovery Agent(s) are registered,   the following message displays 
when you click Next on the Discovery Agent   Selection Wizard Welcome page:

"There were no Discovery Agents or   Target Applications found. Please install the Discovery Agent and 
Target   Applications that you want to use and restart this tool."

Solution

The Discover and Auto Configure application shuts down and   you must install or reinstall the applic-
ations, or register the target   application and Discovery Agent .dlls.

Problem # 4: The target application doesn't load

If the target application does not load, the following message displays   when you click Next on the Dis-
covery Agent Selection Wizard Welcome page:

"Could not load Target: 'TARGETNAME'.   Please install the Target Application that you want to use and 
restart   this tool."

Solution

The Discover and Auto Configure application shuts down and   you must install or reinstall the target 
application.

Problem #5: The Discovery Agent doesn't load

If the Discovery Agent doesn't load, the following message displays   when you click Next on the Dis-
covery Agent Selection Wizard Welcome page:
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"Could not load Discovery Agent. Please   install the Discovery Agent that you want to use and restart 
this tool."

Solution

The Discover and Auto Configure application shuts down and   you must install or reinstall the applic-
ation.

Remote OPC Server Running as a Service

Problem #1: Remote OPC Server running as a service does not display   correct configuration

Some OPC servers should be run as a service when you connect to them   remotely. When you are con-
necting to one of these remote OPC servers,   the Discover and Auto Configure populates the system 
tree with   the item information extracted from the OPC server. However, the configuration   displayed is 
not what is known to be used on the remote OPC server.

Solution

The DCOM identity of the OPC server may require modification. Refer   to your specific OPC server's 
documentation for remote DCOM configuration   settings.

Browsing for OPC Servers

Problem #1: OPC Server browse fails

If no servers were found on the machine, the message "No servers   were found on the machine" dis-
plays. You must then verify that either   the correct machine name/TCP/IP address was entered if you are 
browsing   remote OPC servers, or that the OPC server(s) are correctly installed   on the given machine.

If one or more browse methods fail, a message box displays indicating   the methods used and which 
ones succeeded or failed. It also displays   an error message indicating the reason for failure, as returned 
by the   system. Any server(s) found are listed. You can select a server from the   list or remedy the reason 
for the failure and rerun the search. For more   information about browse methods, refer to Discovery   
Agent Selection Wizard - Select an OPC Data Access Server.

Solution

One possible remedy is modifying your DCOM settings, even if your OPC   server is running locally. For 
more information about DCOM settings, refer   to Setting   Up DCOM for Discovery of Remote OPC Serv-
ers.

Accessing Remote OPC Servers

Problem #1: Connection to remote OPC server fails

After selecting a remote OPC server, the following message displays:

Tagview - ! Connection to server failed:   ProgID=<OPC Server name>:   (ox80070005)

Where <OPC Server name>   is the name of the remote OPC Server you are attempting to connect to.

Solutions
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 l Check your DCOM configuration settings. 
 l Some OPC Servers require that the user (or a group   containing that user) that is logged into the 

local machine and attempting   to connect to the remote OPC server machine, be added to the 
Default Access   Permission list in the remote machine's DCOM configuration.

For more information, refer to Setting   Up DCOM for Discovery of Remote OPC Servers.

 

Troubleshooting the Driver Wizard

Problem #1: Driver is not installed

If the appropriate driver(s) for the Discovery Agent and target application   are not installed on the target 
application, an error message displays,   instructing you to install the driver. 

Solution(s)

 l If you are running the Driver Wizard as a stand-alone   dialog box, close the error message to close 
the Driver Wizard. You can   continue using the selections made on the other wizards, however, 
the   driver related fields are not filled in on the spreadsheet.

 l If you are running the iFIX - All Wizards and   you close the error message, the Driver Wizard 
closes, but the Summary   page appears. Click Finish to fill in all but the driver related fields   on the 
spreadsheet. If you click the Back button on the Summary page,   the Driver Wizard reappears, 
checks for the driver again and displays   the error message again if you have not yet installed the 
driver. Close   the error message again to display the Block Type and Scan Time Wizard.

 l To select a driver from the Select Driver page,   the driver must be installed on the same computer 
as iFIX and   added to the iFIX SCU's Configured I/O Drivers list. The driver must be   on the list of 
supported drivers for the Discovery Agent and target application.   For more information, see Sup-
ported Software.   

 l After the driver is installed, the Auto-Create    option on the driver's Power Tool must be set to ON. 
When you change the   Auto-Create option, you must restart the driver and iFIX for the change   to 
take effect.

For more information about installing the   driver and adding it to the SCU, and about the Auto-
Create option for   the driver, refer to the specific I/O driver online help.

Problem #2: Driver configuration does not display

When the Device Selection page of the Driver Wizard opens for your selected   driver, the configuration 
information defined in the default configuration   file for the locally installed driver displays. You can open 
the driver's   Power Tool from this wizard page to make additions or changes to the driver   configuration. 
However, only changes made to the configuration file for   the local driver are displayed.   If you connect to 
a driver installed on a remote machine and make changes   to its configuration, those changes are not vis-
ible on the Device Selection   page.

Solution

When you click the Run <Driver   Name> Power Tool button on the Device Selection page, the I/O   Driver 
Server Connection dialog box opens. Make sure that you select the   Use Local <Driver Name>   option to 
connect to the driver installed on the local machine. 

 

Troubleshooting Digital Certificate Errors
© 2020 General Electric Company. All rights reserved. 91



All digital certificates for the Discover and Auto Configure   are signed with the “GE” Certificate. The 
same certificate   that iFIX 4.5 uses for its executable (*.exe and *.dll) files. 

If you receive an error (or pop-up message) related to an unsigned digital   certificate, the certificate may 
be related to third-party components.   For instance, errors related to AGLink *.dll files are related to third-
party   API or .dll files. Consult the Help from your driver vendor for more information.
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